iNotes Web Access
Deployment and Administration

- Deploy iNotes Web Access in your organization
- Make an iNotes Web Access environment secure
- Plan for capacity

Tommi Tulisalo
Wolfgang Hass
Leonardo Vidal
Roger Zirn

ibm.com/redbooks
Take Note! Before using this information and the product it supports, be sure to read the general information in “Special notices” on page 155.

First Edition (December 2001)

This edition applies to Release 5.0.9 of Lotus Domino.

Comments may be addressed to:
IBM Corporation, International Technical Support Organization
Dept. TQH Mail Station P099
2455 South Road
Poughkeepsie, NY 12601-5400

When you send information to IBM, you grant IBM a non-exclusive right to use or distribute the information in any way it believes appropriate without incurring any obligation to you.

© Copyright International Business Machines Corporation 2001. All rights reserved.
Note to U.S Government Users – Documentation related to restricted rights – Use, duplication or disclosure is subject to restrictions set forth in GSA ADP Schedule Contract with IBM Corp.
Contents

Preface .......................................................... vii
The team that wrote this redbook .............................. viii
IBM trademarks ............................................... ix
Comments welcome ........................................... x

Chapter 1. Introduction ....................................... 1
1.1 What is iNotes ............................................. 2
1.2 What is iNotes Web Access ............................... 2
1.3 Selecting the best client ................................. 3
  1.3.1 Lotus Notes ........................................ 4
  1.3.2 iNotes Web Access ................................. 5
  1.3.3 iNotes Access for Microsoft Outlook ................ 6
  1.3.4 Domino WebMail ................................... 7
  1.3.5 Mobile Notes ....................................... 8
1.4 Domino Off-Line Services ............................... 8
  1.4.1 Lotus iNotes Sync Manager ......................... 8

Chapter 2. Security ............................................ 9
2.1 Authentication ........................................... 10
  2.1.1 Basic authentication ............................... 10
  2.1.2 Session-based authentication ...................... 11
  2.1.3 Authentication over Secure Sockets Layer (SSL) .... 14
  2.1.4 Name variations .................................. 14
  2.1.5 Logout .............................................. 16
2.2 Enabling Secure Sockets Layer (SSL) ................... 18
  2.2.1 Enable SSL for all databases on the server ....... 19
  2.2.2 Selectively enable SSL on databases ............... 19
2.3 iNotes Web Access and access control ............... 20
  2.3.1 Anonymous access ................................ 20
  2.3.2 Access levels to a user's mail file ............... 22
  2.3.3 Access level to the Forms5.nsf database ......... 27
2.4 Database encryption .................................... 27
  2.4.1 Encrypting databases on the server ............... 27
  2.4.2 Encrypting a mail file on a workstation .......... 29
2.5 Security issues for users on kiosk or Internet cafe .. 30
  2.5.1 How to manually delete temporary Internet files . 30
  2.5.2 Deleting temporary Internet files automatically .. 31
2.6 Differences between iNotes Web Access and Notes security .... 32
Preface

iNotes Web Access is a next-generation Web client that allows you to utilize the most popular Domino functionality with a Web browser. You can work on your mail, use your calendar for personal and group scheduling, and do some advanced task management. In addition, you have access to your contact information and a journal-like notebook. iNotes Web Access also has a customizable Welcome page.

This IBM Redbook offers you information on how to best install, deploy, and configure iNotes Web Access for your environment. It describes how to make your installation secure, keeping unwanted visitors outside of your iNotes Web Access installation yet allowing your users to access their mail files from outside the corporate firewall.

If your organization uses Notes clients to access mail and other services of Domino, you will still find iNotes Web Access useful. A scenario where these clients coexist is explained, and upgrading to such an environment is described in detail.

All the functionality of iNotes Web Access is available for you online as well as offline. How to enable offline access to iNotes Web Access with Domino Off-Line Services is presented.

This redbook gives you details for capacity planning so you can size your environment correctly and describes how to get the best performance out of your servers. It also gives you information on how to integrate Lotus Sametime into your iNotes Web Access environment.

We describe the architecture of iNotes Web Access and, finally, offer some examples of how to make modifications to iNotes Web Access.

This redbook is written for network or Domino administrators deploying iNotes Web Access. We assume that you are thoroughly familiar with administering a Domino server.
The team that wrote this redbook

This redbook was produced by a team of specialists from around the world working at the International Technical Support Organization, Cambridge Center. Some of the information presented was adapted from a Lotus White Paper, *iNotes Web Access Deployment Guide*.

**Tommi Tulisalo** works for the International Technical Support Organization at Cambridge, Massachusetts. He manages projects whose objective is to produce redbooks on all areas of Lotus Software products. Before joining the ITSO in 2001, he was an IT Architect for IBM Global Services in Finland, designing solutions for customers, often based on Lotus software. Tommi is a Certified Lotus Professional at a Principal level in Domino application development.

**Wolfgang Hass** is CEO at Groupware - Schulung Wolfgang Hass in Ettlingen, Germany, a Lotus Authorized Education Center. Wolfgang is a Certified Lotus Instructor since Version 3.0. and Certified Lotus Professional at Principal level in application development and system administration. Since 1995 he has been provided classroom training to developers, programmers and administrators. In addition, he consults companies on deployment of Domino servers, applications and nowadays migration from other systems to iNotes Web Access.

**Leonardo Vidal** is a System Support Specialist in IBM Brazil. He has six years of experience with Lotus Notes/Domino systems on AIX and NT platforms. Leonardo holds a degree in Systems Analysis from PUC University in Rio de Janeiro. His areas of expertise include Domino Server administration, infrastructure and application development.

**Roger Zirn** has been working as a Lotus Pre-Sales IT Specialist with IBM Switzerland since beginning of 2001. He provides technical support for the sales team by doing product presentations and demonstrations about the current Lotus products for customers. Roger is also involved with technical pre-sales activities at customers as well. Before his current job he was a Lotus Notes/Domino developer for almost ten years with several companies, last at Lotus Professional Services.

We would like to thank the following people, who have provided support and guidance for us:

- Ed Brill - Lotus Software
- Lori Davidson - IBM Westford Lab
- Blair Davies - IBM Westford Lab
- Jack Downing - IBM Westford Lab
IBM trademarks

The following terms are trademarks of the International Business Machines Corporation in the United States and/or other countries:

- e (logo)®
- IBM ®
- AIX
- AS/400
- AS/400e
- Enterprise Storage Server
- Everyplace
- iSeries
- Netfinity
- OS/2
- OS/390
- pSeries
- RS/6000
- S/390
- SecureWay
- SP
- SP1

- Redbooks
- Redbooks Logo
- WebSphere
- xSeries
- zSeries
- Lotus
- Notes
- Notes
- Notes
- Notes
- Notes
- Notes
- Notes
- Notes
Comments welcome

Your comments are important to us!

We want our IBM Redbooks to be as helpful as possible. Send us your comments about this or other Redbooks in one of the following ways:

► Use the online Contact us review redbook form found at:
  ibm.com/redbooks

► Send your comments in an Internet note to:
  redbook@us.ibm.com

► Mail your comments to the address on page ii.
Chapter 1. Introduction

The selection of the mail client is not an ultimate selection, excluding the use of other clients. Often, the same user can use different clients in different situations. This could depend on various factors. For example, how is the user accessing the mail, or what kind of task is the user trying to do? The user could be accessing the mail from his or her own workstation in the office, from the home PC, from a PC in an Internet Cafe, from a PDA, or from a smart phone. There could be a different client selection for each of these situations.

In this chapter we introduce you to iNotes Web Access and other products related to it. We discuss the different clients available to access Domino services. We briefly describe some of the clients, and provide information that you can use to determine which clients best suit the needs of your users.
1.1 What is iNotes

iNotes is the name for a family of products that provide Domino messaging, collaboration, and e-business capabilities to Web browser and Microsoft Outlook users. The iNotes family consists of three products:

- iNotes Web Access
- iNotes Access for Microsoft Outlook
- Lotus iNotes Sync Manager

1.2 What is iNotes Web Access

iNotes Web Access is a Web client that allows users to access different Domino services using the Web browser. iNotes Web Access provides the browser user with access to a number of features that were previously only available for users with non-browser clients, such as Lotus Notes. These features are in the areas of messaging, calendar and scheduling, personal information management (PIM), task management, and personal journal. Users can also work offline to manage e-mail messages, contacts, calendars, to-do items, and so forth, from the user interface that iNotes Web Access provides.

iNotes Web Access can be used independently, or together with the Lotus Notes client. Users can use the Notes client while they are in their office environment, and use iNotes Web Access while they are remote and their only choice is to use a Web browser—such as when they are in an Internet Cafe, at another user’s PC, or on their home PC.

Although they are using different clients in different situations, users are still using the same mail file and the information is always up-to-date.

For administrators, iNotes Web Access provides a simple client that is easy and cost-effective to manage and deploy. This is all done from within the same Domino infrastructure that they already manage. The thin-client and server-based deployment model imposes no training requirements, and allows companies to get users up and running quickly.

You might have a Domino installation in your organization and your users have been using Notes clients to access Domino services for some time. So, what’s the big difference with iNotes Web Access compared to earlier releases of the Domino server?
What has been added and what has been changed? What do I, as a Domino administrator, have to do? These are some of the questions this book is intended to answer.

There are some important things to note when you are planning to let your users access their mail files with a browser. It is critical that you keep unwanted users out of your network, even as you enable your users to access their mail from the outside. Chapter 2, “Security” on page 9 describes how to secure your installation.

Starting with Domino release 5.0.8, iNotes Web Access is shipped with the Domino server. iNotes Web Access uses mostly files that reside on a server. In addition to a Web browser, only a few things have to be installed on the user’s workstation if the user will need to access their mail files offline. In case other files are needed locally, they are loaded from the server. Files related to iNotes Web Access on the server are:

- iNotes5.ntf, which is the actual template used to create or upgrade mail files for users
- Forms5.nsf, which contains most of the elements used to build the iNotes Web Access user interface

For details on the purpose and content of these files, see 6.2, “Template architecture” on page 117.

### 1.3 Selecting the best client

A wide range of clients is available to access services provided by a Domino server. To help you determine when to use which client, we briefly explain the following clients:

- Lotus Notes
- iNotes Web Access
- iNotes Access for Outlook
- WebMail
- Mobile Notes

The selection of the client is based on the situation you are in rather than what the specific features of a certain client are.

1.3.1 Lotus Notes

Lotus Notes is an integrated e-mail and e-business software solution for the Internet and corporate intranets. Notes integrates information sources, including e-mail, calendaring, group scheduling, to-do lists, and more. Notes users can exchange messages via the Internet, work with any Web application, read and post topics to Internet newsgroups, search Web directories, and use X.509 certificates for security. Notes users have access to their e-mail and other applications while they are offline, giving them the option to synchronize their work later.

Integration with the Lotus Domino R5 Server makes Notes R5 available as an e-business client, with high functionality, security and customization options. There are built-in collaborative applications, like discussions and document libraries, as well as third-party Domino-based e-business solutions.

When to use Lotus Notes client

If your users need more than just a mail client—but a client to integrate mail, calendar, address book, and to-do lists into workflow, Web, and e-business applications—the client to use is Lotus Notes client.
1.3.2 iNotes Web Access

iNotes Web Access combines Domino messaging, collaboration, and e-business capabilities and provides them to users using Web browsers. iNotes provides centralized management and deployment and a no-touch installation to the user's desktop.

It delivers messaging, collaboration, and PIM functions to Web browsers through an easy-to-use user interface, both online and offline.

When to use iNotes Web Access client

You might want to choose iNotes Web Access for your client in a situation where you’re upgrading from a traditional mail system to Web browser-based mail, or when you are installing your first mail system.

Consider using iNotes Web Access if your users don’t have a designated workstation, or if they have to be able to access their mail files from computers with only a Web browser installed, or from outside the network of your organization.

iNotes Web Access is a wise choice also for organizations using Lotus Notes mail. It does not have to be an exclusive choice between Lotus Notes or iNotes Web Access since you can use both to access your mail file in different situations.

If your organization has Domino WebMail users, you might want to provide them with better functionality by upgrading to iNotes Web Access.
1.3.3 iNotes Access for Microsoft Outlook


The Microsoft Outlook user experience is unchanged with iNotes Access for Microsoft Outlook; users simply work with their mail, calendar, and task data on Domino instead of Microsoft Exchange. Familiar Microsoft Outlook features are supported, including rich text, folders, and integration with Microsoft Office applications.

iNotes Access for Microsoft Outlook also gives Microsoft Outlook users the additional benefits of Domino Messaging features not available with Exchange, including full text search capability for their mailbox, superior mobile capabilities, and native support for Internet standards (SMTP/MIME and HTML).

You connect Microsoft Outlook 98/2000 users to Domino by completing one simple form. Users connect to their new Domino Server with just three mouse clicks.
When to use the iNotes Access for Microsoft Outlook client

Choose the iNotes Access for Microsoft Outlook client if you want to improve the reliability and scalability of your messaging infrastructure, add e-collaboration, and upgrade from Microsoft Exchange to Domino, all without having to change clients.

1.3.4 Domino WebMail

The initial goals for Domino WebMail were to give users the ability to access their Notes mail files with a browser and to provide a better user interface.

When to use Domino WebMail

Domino WebMail would still be a valid option for users who use platforms such as UNIX, Linux, or OS/2, or if your organization is using browsers other than Internet Explorer, such as Netscape Navigator. If you are planning to roll out Domino WebMail because your organization is using Netscape Navigator as the browser client, you might want to wait for the Rnext release (the next major release of Lotus Domino). Support for the Netscape Navigator 4.7 client (on Win32 platforms) for iNotes Web Access is planned for the Rnext release of Lotus Domino.
1.3.5 Mobile Notes

Mobile Notes with Domino Everyplace provides access to your Domino-based applications from your favorite handheld devices, such as personal digital assistants (PDAs) and WAP phones. Mobile Notes means anytime and anywhere access to Notes and Domino through various means. You simply decide what you need, choose the appropriate Domino Everyplace product, and experience Mobile Notes on the device of your choice.

When to use Mobile Notes

Nowadays, many organizations have a lot of users with a constant need to access their mail files and other Domino applications, regardless of the time and place. While mobile, users can use handheld devices to access their Domino applications using Mobile Notes. If your users need to access their mail files using PDAs or WAP phones, it is recommended that you use the native clients of these devices. For detailed instructions about accessing Domino servers with various handheld devices, refer to the IBM Redbook *Lotus Mobile and Wireless Solutions*, SG24-6525.

1.4 Domino Off-Line Services

For users who need to access their mail files while disconnected from the network, Domino Off-Line Services (DOLS) is implemented on a server. Details about installation can be found in 3.5, “iNotes Web Access client deployment” on page 59.

DOLS enables users to work with their mail files offline, as they would with any other Domino Web application. Users can read, create, modify, and delete documents offline, and then synchronize the changes with the application on a server. This is similar to what users have been able to do offline with Notes clients.

1.4.1 Lotus iNotes Sync Manager

Lotus iNotes Sync Manager is installed on the user’s workstation when the user goes offline for the first time, or it can be installed from an installation CD. With Lotus iNotes Sync Manager, the user is able to set various options for synchronization, such as a schedule.
Lotus has always set a high value on the security for Notes and Domino. The same security architecture applies to iNotes Web Access as to all Domino applications designed for the Web. Additionally, there are some security features developed specifically for iNotes Web Access; they are described in this chapter.

We discuss the security features of iNotes Web Access in general, as well as the things you should consider before you allow access to your server with a Web browser. We offer ideas for configuring the Internet Explorer and security settings on your Domino server.
2.1 Authentication

To access their mail files, users must first authenticate with the Domino server. The most commonly used authentication option, basic name-and-password authentication, requires a person record in the Domino Directory or secondary directory, configured by means of Directory Assistance, containing the user’s name and an Internet password.

Figure 2-1 shows a person record in a Domino Directory.

![Figure 2-1  A person record in a Domino Directory](image)

How users are authenticated against a Domino server is set in the server document. There are three options to choose from: disabled (Basic authentication), single server, or multi-server. (Single server and multi-server are both session-based authentication schemes.) These three methods are described in the next two sections.

2.1.1 Basic authentication

Basic authentication is the default setting for authentication. If you open your mail file with a browser, you should see a dialog box similar to the one in Figure 2-2.
We recommend that users do not select the check box “Save this password in your password list” on their browser. If this box is checked, the password is saved on the workstation, and unauthorized users could access this mail file later since both the username and the password would be pre-filled.

Depending on where the database resides and on the authentication settings of the server’s Internet ports, you might have to log in again when accessing another database not in the same directory. For example:

Open an iNotes Web Access mail file with a URL:
http://yourserver/mail/filename.nsf

The browser keeps track of user credentials based on the realm that the Domino server sends to the browser. A realm is a string, which is typically a URL path, that the server sends to indicate the location, or path, for which the user has been authenticated. In this case the top-level realm would be yourserver/mail. If you open another database which resides in another directory, for example yourserver/help/help5_client.nsf, you will be prompted to authenticate again since yourserver/help is not a subdirectory of yourserver/mail.

To avoid users being prompted to authenticate multiple times, you can enable session-based authentication.

2.1.2 Session-based authentication

Session-based authentication allows users to authenticate once against either a single Domino server or several other servers.
With session-based authentication turned on, it is possible for a user to log out without closing their Web browser. Session-based authentication also enables customization of the login prompt and configuration of session time-outs for users. For more information on configuring the Domino server for Web authentication, refer to the Domino 5 Administration Help database (help5_admin.nsf) and the appropriate Release Notes database.

To set the authentication option, open the server document and select Internet Protocols -> Domino Web Engine. The “Session authentication” field includes a pull-down list from which you can choose Multi-server, Single Server, or Disabled, as shown in Figure 2-3.

![Figure 2-3 Enable session authentication](image)

**Note:** To use session authentication, Web users must use a browser that supports cookies since Domino uses cookies to track user sessions.

After session authentication has been enabled, users have to log on using a form instead of a dialog box. The users have to enter their username and password in that form to authenticate. It is possible to customize this form; Figure 2-4 on page 13 shows the default format.
We set up multi-server authentication in our environment. There was one Sametime 2.5 server among the iNotes Web Access servers. Figure 2-5 on page 14 shows how we implemented Sametime within the iNotes Web Access Welcome page. As you can see, the user is already authenticated within Sametime.
2.1.3 Authentication over Secure Sockets Layer (SSL)

If the users access their mail files from outside the corporate firewall, we strongly recommended that you use SSL for the connection. SSL encrypts information, such as the name and the password, sent over the network between client and server. Without SSL, the name and password are transferred as plain text and could be captured by anyone with a network sniffer or trace tool.

2.1.4 Name variations

You can control how rigorously Domino authenticates Web users. On the Security tab of the Server document, the setting "Web server authentication" (Figure 2-6 on page 16) gives you two choices:

- **More name variations with lower security**: Domino tries to authenticate users based on the name and password entered. This authentication method can be vulnerable to hackers who attempt to access a server through a legitimate user account by guessing names and passwords. This choice is the default and is the Web server lookup behavior used in earlier releases of
Domino (R4.6x). This option allows users to enter any of the following in the name and password dialog box in a Web browser:

- Last name only, for example Bullock
- First name only, for example Sandra
- Short name, for example sbullock
- Common name, for example Sandra Bullock
- Full hierarchical name, for example Sandra Bullock/Zurich/IBM
- Any alias in the User name field, for example sb

▶ Fewer name variations with higher security: This lookup technique is less vulnerable to attacks because a single authentication attempt does not produce as many matches, lessening the likelihood that a guessed password matches. This choice is recommended for tighter security. It requires users to enter only the following in the name and password dialog box in a Web browser:

- Common name, for example Sandra Bullock
- Full hierarchical name, for example Sandra Bullock/Zurich/IBM
- Any alias in the User name field, for example sb.

Attention: Unlike with passwords for Notes IDs, there is no support to set a minimum length for Internet passwords initially. iNotes Web Access requires a password of at least eight characters if you change it from within iNotes Web Access. However, it is possible to access iNotes Web Access with an initial password of less than eight characters. The administrator should provide all iNotes Web Access users with an initial password of at least eight characters to avoid confusion.

See Lotus Knowledge Base, Document #186611, for additional information.

You can access the Lotus Knowledge Base from the Lotus Support Web site: http://www.lotus.com/home.nsf/welcome/support

Figure 2-6 on page 16 shows where you select whether to use fewer or more name variations for authentication.
2.1.5 Logout

Many browsers store both logon credentials and private data in memory, typically up to 30 pages, which is not reliably discarded until the browser is closed. iNotes Web Access provides a “Logout” button (Figure 2-7 on page 17) that closes the entire browser session, discarding the in-memory files and attempting to close the browser window. This is to prevent anyone from accessing the user’s mail file by clicking the back button, and viewing personal information from the previous screen while their browser is open and unattended.

The browser remembers the user’s authentication information while it is still open. When all browser windows are closed, cached files are removed from the browser’s cache, so that no one can access the user’s personal iNotes Web Access data. However, there are certain types of personal data that will not be removed unless the user explicitly empties the temporary Internet files folder through a menu command in the browser. For specific instructions, see 2.5.1, “How to manually delete temporary Internet files” on page 30.
Use the following steps to log out of iNotes Web Access:

1. Click the **Logout** button.

![Figure 2-7 The Logout button](image)

2. iNotes Web Access displays a logout window. As shown in Figure 2-8 on page 18 the window contains information about the logout procedure and directions for the user to let the window close down.
2.2 Enabling Secure Sockets Layer (SSL)

There are two options to enable Domino databases for SSL connections:

- Enable SSL for all databases in the server document in the Domino directory.
- Selectively enable SSL on databases in the database properties.
2.2.1 Enable SSL for all databases on the server

1. Open the server’s entry in the Domino directory. Select **Ports -> Internet Ports -> Web**.

2. Change TCP/IP port status to **Redirected to SSL**.

![Figure 2-10 Enable SSL for all databases](image1)

2.2.2 Selectively enable SSL on databases

1. Select **File -> Database ->Properties**.

2. From the **Basics** tab, choose **Web access: Require SSL connection** (Figure 2-11).

![Figure 2-11 Enable SSL for a database](image2)
For more information on how to set up SSL on a Domino Server, refer to the IBM Redbook, *Lotus Notes and Domino R5 Security Infrastructure Revealed*, SG24-5341, or see the document “Setting up SSL for Domino Servers,” which is in the *Domino 5 Administration Help* database (help5_admin.nsf).

2.3 iNotes Web Access and access control

iNotes Web Access is a Domino Web application, and access to iNotes Web Access is controlled by the administrator’s configuration of the Domino security features and by the access control lists (ACLs) of the databases that are part of the iNotes Web Access application. The minimum level of access required for most functionality, including the ability to delegate mail and calendar entries, is Editor.

Access levels, assigned to users in a database ACL, control which tasks users can perform in the database. Access level privileges enhance or restrict the access level assigned to each name, which can be an individual user or a group, in the ACL. Access levels assigned to servers in a database ACL control what information within a database the server can replicate.

2.3.1 Anonymous access

When you set up Anonymous access in a database ACL, Web browser users can access servers without identifying themselves. Domino does not record these users’ database activities (meaning no entry is made in the Log file or in the User Activity log of the database).

ACLs of databases don’t necessarily have the Anonymous entry by default. When deploying iNotes Web Access, we recommend that you always add an Anonymous entry, with No Access assigned to it, to the ACL for all mail files. This will prevent users from accessing other users’ mail files.

**Note:** If there is no Anonymous entry in the ACL of the database, a user has the access level that is assigned to the Default entry.

Table 2-1 on page 21 shows individual access levels assigned to different ACL entries for the iNotes Web Access mail we used in this redbook. Both the Default and Anonymous entries were set to No Access to prevent other users, whether authenticated or not, from accessing the mail file. #Admin is a person group, containing administrators of your Domino/iNotes Web Access environment.
Table 2-1: Access levels for an iNotes Web Access mail file ACL

<table>
<thead>
<tr>
<th>ACL Entry</th>
<th>Access Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Default-</td>
<td>No Access</td>
</tr>
<tr>
<td>#Admin</td>
<td>Manager</td>
</tr>
<tr>
<td>Wolfgang Hass/USR/iNOTESMIG</td>
<td>Editor</td>
</tr>
<tr>
<td>Anonymous</td>
<td>No Access</td>
</tr>
<tr>
<td>LocalDomainServers</td>
<td>Manager</td>
</tr>
<tr>
<td>OtherDomainServers</td>
<td>Reader</td>
</tr>
<tr>
<td>STR1/SRV/INOTESMIG</td>
<td>Manager</td>
</tr>
</tbody>
</table>

Figure 2-12 shows an example of an ACL with Anonymous entry set to No Access and Read public documents selected. This option is selected to allow other users to access the calendar information for this user.

Figure 2-12: Example ACL for Anonymous: No Access, Read public documents
When users access an iNotes Web Access mail file with an ACL like the one in Table 2-1 on page 21, using a Web browser, iNotes Web Access opens. To access the mail, calendar, preferences, and other features, users have to click Login, as shown in Figure 2-13. Then they have to enter their name and Internet password to authenticate themselves.

Figure 2-13   Login hotspot

2.3.2 Access levels to a user’s mail file

It is most common to grant Manager access to the owner of the mail file while they are using the Notes client. Since Domino R5, it is possible to reduce this to Editor access during the registration process for new users.

Whatever settings have been chosen for the owner on the Basics tab within the ACL, the access to a mail file using a browser normally is Editor. This is based on the Maximum Internet name & password access in the Advanced ACL settings, as shown in Figure 2-14 on page 23.
Chapter 2. Security

Figure 2-14   Setting Maximum Internet name & password to Editor

Table 2-2 shows what features are available when different access levels are assigned to the user. The table shows that the user needs at least Designer access to use all these features.

Table 2-2   Access levels to the user’s mail file

<table>
<thead>
<tr>
<th>ACL access level</th>
<th>Maximum Internet name &amp; password</th>
<th>Change Internet Password available?</th>
<th>Out of Office agent available?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Editor</td>
<td>Editor</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Editor</td>
<td>Designer</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Designer</td>
<td>Editor</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Designer</td>
<td>Designer</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Note: The option Change Internet Password is only available to the owner of the mail file!
Minimum access level required to access mail file
The minimum access the owner of a mail file needs is Editor. Provided with this access level, the user is able to change the delegation settings.

Access level required to use Out of Office agent
In order to activate the user's Out of Office agent, the user's access level to the mail file must be raised to Designer.

With a lower level of access than this, a message box will indicate that the user has insufficient access to perform this operation and will show the user's current access level (Figure 2-15).

![Figure 2-15 Insufficient access to use Out of Office agent](image)

Access level required to change Internet password
Even with Reader access or less to the Domino directory, the user is able to change their Internet password, but Designer access to the user's own mail file is required.

Figure 2-16 on page 25 shows where you can change your Internet password. Click Change to open a window where you can change the password.
Chapter 2. Security

Figure 2-16 Change Internet Password section on the Preferences tab

Type the old password first, then the new password, and finally the new password again to confirm the change.

Figure 2-17 Change Internet password window

Note: If you do not see a Change button in the Change Internet Password section of the Preferences dialog, even though access levels are set correctly, this feature may have been turned off. See 3.3, “Server configurations” on page 44 for details about how to enable and disable this feature.
Minimum access for Delegation

In order to change any settings on the Delegation tab, shown in Figure 2-18, Editor access to the user's own mail file is required. This works according to the behavior of a regular Notes client, where ACL settings are specified by the mail file's Administration server.

The respective delegate needs to have Author access to the mail file to create calendar entries on behalf of the mail file owner.

![Delegation tab on Preferences](image)

*Figure 2-18  Delegation tab on Preferences*
2.3.3 Access level to the Forms5.nsf database

The Forms5.nsf database is one of the databases included as part of iNotes Web Access. It contains most of the JavaScript, pass-thru HTML, and images used to implement the user interface of iNotes Web Access.

In order for iNotes Web Access to function correctly, make sure that Anonymous is assigned with Reader access to the database (server's data directory)\iNotes\Forms5.nsf. You will not see an entry for this database in the Catalog.nsf database, but you can find the database by clicking the Domino Administrator -> Files tab or by creating a bookmark in your Notes bookmarks folder.

2.4 Database encryption

Database encryption provides an additional layer of security because ACL settings do not protect locally stored databases.

2.4.1 Encrypting databases on the server

The use of local encryption of all databases on the server may further reduce the risk of confidential information on Domino servers being accessed from outside a corporate firewall. This requires the server ID file to be protected with a password. In most environments where servers are physically secured, this may not be a necessary measure. However, it is a valid option.

To encrypt a database:

1. You must have Manager access in the database ACL.
2. Select the database icon from your bookmarks page, and select **File -> Database -> Properties** (see Figure 2-19 on page 28).
3. Click the **Database Information** tab, then **Encryption**.

4. Choose **Locally encrypt this database using:** (see Figure 2-20) and then choose an encryption level:
   - Simple
   - Medium (default)
   - Strong

5. If the database resides on the server, it will be encrypted using the server’s **Public Key.** Otherwise, click **For** and choose the appropriate user ID to encrypt the database.
2.4.2 Encrypting a mail file on a workstation

With Domino R5.09 or later it is possible to encrypt mail on the workstation locally. Users can select simple, medium, or offline encryption for the offline mail file.

To encrypt the mail file, select Encrypt mail file locally on the Other tab of Preferences, as shown in the Figure 2-21. Select the level of the encryption. The mail file is encrypted locally next time you synchronize your local mail file.

![Figure 2-21 Encrypting a mail file locally](image)

**Note:** If you do not see the Encrypt mail file locally option in the offline section, this feature may have been turned off. See 3.3, “Server configurations” on page 44 for details about how to enable and disable this feature.
2.5 Security issues for users on kiosk or Internet cafe

iNotes Web Access lets you easily access your Notes mail, calendar, contacts, to-do list, and notebook directly from anywhere, such as at a kiosk or Internet cafe, or at home.

As described in 2.1.5, “Logout” on page 16, the logout function on iNotes Web Access sends a logout command to the server to end a session, if session authentication is being used. iNotes Web Access also closes the browser window to prevent another user from hitting the Back button to view personal information from the previous screen. In addition to secure logout, iNotes Web Access does some sophisticated things with caching algorithms. This is to prevent the storage of information in the local browser cache in a format that someone could easily view.

It should be noted that the secure logout function does not clear the browser’s local cache. Because Internet Explorer stores content in the browser’s cache, it is possible to access that information programmatically. iNotes Web Access is unable to delete those files for users, therefore they must do it by themselves as shown in Figure 2-22 on page 31, or configure the browser to prevent the local storage of information (Temporary Internet files) after the session has terminated, as shown in Figure 2-24 on page 32.

2.5.1 How to manually delete temporary Internet files

1. On Internet Explorer 5.01 or above, select Tools -> Internet Options.
2. Click on **Delete Files**.

3. Click **OK** to confirm the deletion (Figure 2-23 on page 31).

### 2.5.2 Deleting temporary Internet files automatically

There is an option to configure Internet Explorer to empty temporary Internet files automatically. This can be enabled on Internet Explorer 5.01 or above by choosing **Tools -> Internet Options -> Advanced** tab (see Figure 2-24 on page 32). Check the option “Empty temporary Internet file folders when browser is closed.”
2.6 Differences between iNotes Web Access and Notes security

Most of the security features that the Notes client user has are also available to the iNotes Web Access user. However, there are also some features that are implemented differently.

2.6.1 Protection against malicious code

In the Notes client, an Execution Control List (ECL) is used to protect data on a user's workstation. With ECL you can limit what can be done by formulas and scripts on the user's workstation. For example, with correctly set ECL, you can prevent the use of code to access the file system, other Domino databases, and external code. For more information on ECLs, see the document “The workstation ECL,” which is on the Domino 5 Administration Help database (help5_admin.nsf).
It is possible to write code that could do damage on a user’s workstation and to attach that code to a mail message. Due to the nature of the Web client, there is no ECL available to protect a user’s machine against malicious code. Instead there is an iNotes Web Access active content filter, which removes potentially malicious active content from the mail message before the message is delivered to the user. This filter will protect against the most common attacks. It is not designed to protect against viruses or other hostile code inside attachments.

**Tip:** Providing a user’s machine with a personal firewall could also be a useful step to improve security.

### 2.6.2 Authentication method

When users access a Domino server with a Notes client, they are using Notes ID files for authentication. There is no ID file available when accessing a Domino Web application, such as iNotes Web Access, with a Web browser. Users authenticate against the Domino server with name and password only. However, there are several techniques available to increase security, as described in 2.1, “Authentication” on page 10. In addition, it should be possible to use X.509 certificates to authenticate Web browser users accessing a Domino Server. Refer to the IBM Redbook, *Lotus Notes and Domino R5 Security Infrastructure Revealed* (SG24-5341), for information on how to create and distribute X.509 certificates.

### 2.7 Reverse proxies

A proxy server filters the requests of internal clients to one or more servers on the Internet (Figure 2-25 on page 34). Only the proxy server is known to the outside world. The architecture of the proxy delivers the information to the requesting client.
A reverse proxy is based on the idea of the proxy (Figure 2-26 on page 34). A request to this Web server is delivered to the reverse proxy. The reverse proxy resolves the requested URL, sends it to the appropriate server, and delivers the information from the answering server to the inquiring Web browser. Therefore, only the Web server containing the reverse proxy is known to the Internet.

In some network environments, administrators deploy reverse proxy servers to allow users to access other HTTP servers inside the firewall from the Internet. Reverse proxy servers rewrite URLs within Web pages before returning the pages to the user. The rewrites are intended to redirect all subsequent URLs through the reverse proxy server. Some reverse proxies only rewrite URLs within
non-JavaScript portions of the Web pages, while others rewrite full URL strings found within JavaScript as well. In either case, any Web application that programmatically builds URLs using JavaScript will need to design URLs in the application to take this behavior into account.

iNotes Web Access has been engineered to work well with reverse proxy servers. Each of them behaves in its own way and has to be set up accordingly. Refer to the documentation of each product for installation and configuration details.

iNotes Web Access was tested with following products:

- Sun iPlanet Web Proxy Server 2.0 sp2
- Tivoli SecureWay Policy Director 3.2
- IBM WebSphere Edge Server 1.0

### 2.8 Firewall issues

Refer to chapter 5 “Domino and Firewalls Revealed” in the redbook *Lotus Notes and Domino R5.0 Security Infrastructure Revealed* SG24-5341, which gives you a good review for the deployment of firewalls and their interaction with your Domino infrastructure. For online access refer to:

http://www.ibm.com/redbooks

You have to open additional ports in order to maintain other services through your firewall. Table 2-3 shows which ports have to be opened in your firewall for the use of iNotes Web Access.

<table>
<thead>
<tr>
<th>Service</th>
<th>Needed for</th>
<th>Port</th>
<th>SSL Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP</td>
<td>Web browser access</td>
<td>80</td>
<td>443</td>
</tr>
<tr>
<td>SMTP</td>
<td>Incoming/outgoing mail</td>
<td>25</td>
<td>465</td>
</tr>
<tr>
<td>NRPC</td>
<td>DOLS replication</td>
<td>1352</td>
<td>-----</td>
</tr>
</tbody>
</table>

### 2.9 Client-side security

This section describes some client-side (browser) security considerations when using iNotes Web Access.
2.9.1 Cookies

Cookies are a method for sending session-based information from browser to server. Cookies normally contain information about the user and/or user session.

To have iNotes Web Access work properly, the browser has to allow cookies. iNotes Web Access uses one cookie, named Shimmer, where all application settings are stored. This cookie is only retained in memory and never written to the user's workstation.

2.9.2 Private data and browser cache

iNotes Web Access makes a distinction between iNotes Web Access design elements and personal data, with respect to the browser's cache. In general, the HTML in which personal data is generated is set, using the Cache-Control HTTP response header, to a value of “no-cache,” which advises the browser that it should not store the page in the browser's file-system cache. Design elements such as the JavaScript, .gif files, and blank forms of iNotes Web Access are marked with a one-year expiration. This facilitates better performance for iNotes Web Access when used over a dial-up connection, since the browser will not attempt to download these design elements if they are already resident in the browser's cache (assuming the browser's setting for “Empty temporary Internet files when browser is closed” option is not set.)

One exception to this rule is that iNotes Web Access generates a .pdf file to print the user's Calendar. This .pdf file, containing user data, is marked “private” since it must be present in the cache in order for Adobe to view it. This file is kept open for up to one minute following the close of the Adobe Acrobat Reader. Moreover, because of an issue with Internet Explorer (see article ID: Q272359 on http://www.microsoft.com), iNotes Web Access sets Cache-Control to “none” for XML data returned when SSL is in use. This means that view data is left in the cache in this scenario. This XML data is the data used by views to show information.

Note that many browsers store both logon credentials and private data in memory; they are not reliably discarded until the browser is closed. For this reason, iNotes Web Access provides a “Logout” button (Figure 2-7 on page 17) to close your entire browser session and discard the in-memory files. Users can also set their browser to delete all files from the Temporary Internet files folder when the browser window is closed. This would delete any code and data that may have been left in the cache. For specific instructions, see 2.5.1, “How to manually delete temporary Internet files” on page 30.
2.9.3 Encryption

iNotes Web Access does not currently support reading and sending encrypted mail. When trying to read encrypted mail, you will see a message in place of the body of the message that indicates the mail has been encrypted and must be viewed using a Notes client. iNotes Web Access also provides a user preference to set a “default copy and close” folder that will enable “one click” saving of mail messages into a folder such as “read later with Notes” to allow users to more effectively store these mail messages for subsequent review with the Notes client.

2.10 An example of iNotes Web Access network environment

Figure 2-27 on page 38 illustrates the iNotes Web Access network setup we used as an example in preparing this redbook. The Domino network was split into two separate Notes domains for the following purposes:

- iNotesMig domain
  - To migrate an existing R4.67 environment into R5.08 iNotes Web access.
- iNotes domain
  - To use iNotes Web Access with Domino Clustering.
  - To build connectivity from iNotes Web Access to QuickPlace and Sametime.
  - To access the domain servers from the Internet. Our environment is secured by firewalls and the access to iNotes Web Access is only given through a reverse proxy server, which is on the demilitarized zone.
Figure 2-27  iNotes Web Access network environment used in this redbook
Deployment

This chapter discusses some of the factors you should consider when deploying iNotes Web Access on your Domino server infrastructure. There are many possible variations of Domino architecture, each of which has some unique characteristics to consider. For example, many organizations may want to leverage their prior investments with Notes clients and Domino servers for some period while migrating their users over gradually, until the majority are using iNotes Web Access. Other organizations may want to keep users accessing their Notes clients in the office, and accessing their mail files using iNotes Web Access either from home or from an Internet cafe.

This chapter provides important deployment guidelines that are useful regardless of size, hardware, or operating system used.

This chapter covers the following topics:

- Server and client requirements
- Scenarios - running different mail clients on a single server
- Server configurations
- Migration of users
- iNotes Web access client deployment
- Uninstalling iNotes Web Access client
- Directory Assistance and Directory Catalog
- Welcome page
- Server deployment: Quick reference
3.1 Server and client requirements

This section describes both client and server requirements for iNotes Web Access deployment. These requirements and recommendations should be used as general guidelines only.

3.1.1 Client requirements

**Software**
- Win32 Internet Explorer 5.01 Service Pack 1 or above.
- Adobe Acrobat Reader, version 4.0 or above. (This is used for calendar printing.)

**Operating system**
- Windows 95, Windows 98, Windows NT 4.0 or Windows 2000

**Hardware**
Based on customer feedback, we recommend that you have at least a Pentium II 400 MHz machine with 128 MB of memory in order to have reasonable client-side performance.

3.1.2 Server requirements

**Software**
- Lotus Domino 5.0.8 server or later

**Operating system**
- AIX 4.3.3
- OS/400
- OS/390
- Solaris Sparc 7, 8
- Windows 2000 Professional, Server, Advanced Server
- Windows NT Server 4.0 Service Pack 4 and above
Table 3-1 Memory requirements

<table>
<thead>
<tr>
<th>Platform</th>
<th>Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows NT / 2000</td>
<td>256 MB</td>
</tr>
<tr>
<td>UNIX</td>
<td>256 MB</td>
</tr>
<tr>
<td>iSeries</td>
<td>1 GB</td>
</tr>
<tr>
<td>S/390 and zSeries</td>
<td>700 MB</td>
</tr>
</tbody>
</table>

Server disk space

- Minimum 750 MB, 1 GB or more recommended
- Windows 2000, 2 GB (with a minimum of 1 GB of free space)

3.2 Running different mail clients on a single server

Notes, WebMail, and iNotes Web Access are all based on the same physical mail file, so the upgrade path is very simple. But there are several important considerations to be aware of when deploying iNotes Web Access clients in a mixed environment. In this section we describe different Notes environments, and we provide deployment guidelines to help you avoid problems that could prevent overall productivity during this migration period.

3.2.1 Deploying in a predominantly pre-5.0.8 environment

It is quite common that not all of the servers can be upgraded in a short period of time. This could raise coexistence issues, where different versions of Domino servers run in the same infrastructure, thus sharing the same directory, the same system databases and database replicas. In general, Domino R5.x was designed to work in a mixed environment.

You may choose to deploy just one or a small number of Domino servers with iNotes Web Access in a server infrastructure where the majority of servers are R4 and pre-5.0.8 servers, to accommodate a gradual migration to a 5.0.8 or newer server. In this case, the administrators must be careful to recognize that iNotes Web Access users will be using the new iNotes Web Access template design, so template replication to earlier server releases should be prevented. We recommend that you turn off design replication on mail file replicas on the 5.0.8 or newer servers. This is described in more detail in 3.4, "Migration of users" on page 48.
3.2.2 Using Notes clients and iNotes Web Access on the same mail file

Many organizations will want to deploy Notes and iNotes Web Access clients against the same Domino server. Since iNotes Web Access requires the 5.0.8 or newer server, this deployment scenario assumes that there may be Notes clients and iNotes Web Access clients being configured against the same 5.0.8 or newer server. Many of these client users may even switch between the Notes and iNotes Web Access client against their own mail file. This mixed client environment is fully supported by 5.0.8 because the iNotes Web Access template is compatible with earlier releases of the Notes client.

When deploying into this type of mixed client environment and using the iNotes Web Access template, Notes users will continue to see the standard Notes client user interface to which they are used to. When switching to use the iNotes Web Access client, they will see a new user interface of iNotes Web Access that includes such elements as the Date navigator, Contacts, and Notepad. As is the case with Notes template replication, unless someone specifically turns off design replication, the iNotes Web Access template will replicate to any local mail replicas on the user's Notes workstation.

Any R5 Notes clients are supported to interoperate with an iNotes Web Access user. It does not need to be a 5.0.8 or newer version of the Notes client to be able to, for example, send e-mail to an iNotes Web Access user.

3.2.3 Using iNotes Web Access and Webmail in a mixed environment

iNotes Web Access has more features and better performance than WebMail. iNotes Web Access has approximately 90 percent of the most-requested features that were not in WebMail—for example, unread marks, spell check, out-of-office agent, unlimited attachment support, and more. And iNotes Web Access performance targets are well above the performance levels of WebMail.

In the initial release of iNotes Web Access, WebMail will continue to exist, in part because of the platform limitations initially with iNotes Web Access. The inclusion of WebMail support ensures that users can access their Domino server no matter what browser is on the device they are using. For example, if you attempt to retrieve your mail from an airport kiosk, an Internet cafe, or a customer's location, you have no control over what browser type or version you will find on those machines. If you use a browser that is unsupported by iNotes Web Access, the Domino server will render the WebMail experience, rather than an error message.
There can be organizations that choose to have both iNotes Web Access and WebMail deployed because of the platforms they are using. If at some point the platform you are using is supported by iNotes Web Access, you can upgrade your users easily by changing the template from which they are inheriting their design.

Although this can be done, there are several important points to consider during deployment planning:

- Consider the overall server bandwidth implications. Plan your user deployment in line with the server's scaling capabilities. You want to be sure that CPU use is not maximized during the anticipated peak user periods so that overall performance and response times remain acceptable.

- Inform your users that a user interface parameter setting (&ui=argument) is available to easily switch between WebMail and the iNotes Web Access. The first example shows how to open a user’s mail with the iNotes Web Access user interface; the second example shows how to switch to a WebMail user interface:

  iNotes Web Access user interface:
  
  http://www.acme.com/mail/jsmith.nsf?OpenDatabase&ui=inotes

  Domino WebMail user interface:
  
  http://www.acme.com/mail/jsmith.nsf?OpenDatabase&ui=webmail

**Table 3-2 User interface parameter setting**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>inotes</td>
<td>&lt;default&gt; Normal iNotes Web Access user interface</td>
</tr>
<tr>
<td>webmail</td>
<td>Provides the user with the WebMail user interface. This state is remembered on the server and if the server is set up for basic authentication, it affects all future URLs to this database from the same client machine or any client machine.</td>
</tr>
</tbody>
</table>

**Note:** The selected user interface, WebMail or iNotes Web Access, is shown until the user specifically selects the other user interface via the URL, as shown in the examples. After this, the other user interfaces will be used.

Opening the mail file without the &ui= parameter will result in the user interface being iNotes Web Access.
3.3 Server configurations

This section describes settings and configurations required for iNotes Web Access servers.

3.3.1 iNotes Web Access tab in server configuration document

The configuration document in the R5.0.9 Domino Directory, as shown in Figure 3-1, has a set of features available for iNotes Web Access. By default, most of these features are available to the iNotes Web Access client unless you take action to disable them.

![Configuration for R5.0.9 Domino Directory](image)

Figure 3-1  iNotes Web Access Configuration settings

The Configuration document in the R5.0.9 Domino Directory contains the settings defined in Table 3-3 on page 45.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archiving on server</td>
<td>Allows users to create archive databases on the server.</td>
</tr>
<tr>
<td>Full-text indexing</td>
<td>Allows users to create a full-text, searchable index of their mail, to-do items, notebook, and contacts list. When enabled, users have the possibility of creating an index.</td>
</tr>
<tr>
<td>Modification of Internet password</td>
<td>Allows users to change their Internet password from Preferences. When disabled, there is no password change user interface in Preferences.</td>
</tr>
<tr>
<td>Calendar printing</td>
<td>Allows users to print calendar entries. When disabled, there is no print button on Calendar view pages.</td>
</tr>
<tr>
<td>Custom ActiveX file attachment utility</td>
<td>Allows you to use the custom file upload utility provided by iNotes Web Access. This utility provides advanced features such as drag and drop file attachment, easy file selection, and multiple file views. When disabled (the default), a DHTML implementation using the standard File input element will be utilized.</td>
</tr>
<tr>
<td>Alarms</td>
<td>When disabled, no alarm will pop up.</td>
</tr>
<tr>
<td>Alarm polling time</td>
<td>Alarm monitor will check for alarms every XX minutes.</td>
</tr>
<tr>
<td>Minimum allowed mail polling time</td>
<td>Check for new mail should occur no less than every XX minutes.</td>
</tr>
<tr>
<td>Welcome Page URL</td>
<td>Any valid URL will override the existing Welcome Page.</td>
</tr>
<tr>
<td>Welcome Page title</td>
<td>If URL is valid, this title will be shown in the title area of the Welcome Page.</td>
</tr>
<tr>
<td>Allow user to edit the welcome page</td>
<td>Enabling this option allows users to edit the custom welcome page.</td>
</tr>
<tr>
<td>Validate name and set alternate name items</td>
<td>Alternate names provide the ability to represent a username in a language preferable to the user.</td>
</tr>
<tr>
<td>Allow user to configure alternate name display setting</td>
<td>Allows users to turn on/off alternate name support and choose the preferred language for an alternate name in the preferences dialog.</td>
</tr>
<tr>
<td>Allow user to choose the preferred language</td>
<td>Allows users to choose the preferred language for an alternate name in the preference dialog.</td>
</tr>
<tr>
<td>Alternate name language</td>
<td>This is a global setting that overrides any user setting for alternate name language.</td>
</tr>
</tbody>
</table>
### 3.3.2 HTTP settings on the Internet tab

The Internet tab in the server document on Domino Directory contains HTTP settings for Domino Web servers (see Figure 3-2 on page 47). See the *Domino 5 Administration Help* database (help5_admin.nsf) for details about each field in the Server document.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encrypt offline mail files</td>
<td>Offline encryption provides enhanced security. If you enable this feature, you can select the level of encryption: simple, medium, or strong.</td>
</tr>
<tr>
<td>Allow user to override offline encryption setting</td>
<td>Allows users to override the offline encryption setting through a checkbox in the iNotes Web Access preferences dialog.</td>
</tr>
</tbody>
</table>
3.3.3 HTTP task

iNotes Web Access requires that the `http` task is running on the server. If your server is not running it, you can edit the ServerTasks setting in the NOTES.INI file to include the command `http`. It starts the Web server automatically when you start Domino.
Starting and stopping the Domino Web server

Table 3-4 shows different server console commands related to the http task.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Perform this task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start the Web server manually</td>
<td>Enter \texttt{load http} at the console</td>
</tr>
<tr>
<td>Stop the Web server</td>
<td>Enter \texttt{tell http quit} at the console</td>
</tr>
<tr>
<td>Use new server configuration settings without stopping and restarting the http server task.</td>
<td>Enter \texttt{tell http restart} at the console</td>
</tr>
</tbody>
</table>

3.3.4 Preparing a server for offline users

If you are planning to have offline users in your environment, some configurations are required on the server. See 3.5.2, “Deploying iNotes Web Access for offline users using DOLS” on page 60 for more information.

3.4 Migration of users

In this section we discuss two scenarios in which users who have been using Notes clients are migrated to iNotes Web Access. Depending on the scenario, users will either have Notes clients after migration or not.

3.4.1 Users using both clients after the migration

In this scenario users still have access to their Notes client after migration. The Domino server that your organization is using for iNotes Web Access has to be version 5.0.8 or later. If not, the first thing to do is to upgrade your Domino server to a newer version.

Convert mail files to iNotes Web Access as described in 3.4.3, “Converting mail files to iNotes Web Access” on page 58.

After the conversion, users' mail files will have two additional actions available from the Actions -> iNotes Web Access menu, as shown in Figure 3-3 on page 49. These actions are used to synchronize Contacts and Journal between the mail files and the respective databases.
Starting with Domino version 5.0.9, the action Synchronize Contacts also synchronizes Person and Group documents between the Personal Address Book and a user's mail file. The iNotes Web Access user will be able to create and manage personal groups, similar to the Notes client Personal Address Book. These personal groups can be used for all mail, calendaring and scheduling features.

3.4.2 Users using only iNotes Web Access after migration

In this scenario we migrate users who have been using Domino mail with their Notes clients. After the migration these users will not have the Notes client available.

The modifications and scripts described in this section are not part of the iNotes Web Access product. Instead, we created them to enable this migration process. You can find these modifications on the Redbooks Web site. Specific instructions can be found in Appendix B, “Additional material” on page 151.

Documents that are currently stored in other databases have to be copied into the mail file. This is because the user does not have the Notes client to access these databases after the migration. Documents to be copied are:

- Business Cards (R4) / Contacts (R5) from Personal Address Book database
- Group documents from Personal Address Book database
- Journal Entry documents from the user's Journal database
In addition, the Notes ID file of the user is copied. This is done so users will have offline access to their mail files via DOLS.

The Domino server that your organization is using for iNotes Web Access has to be version 5.0.8 or later. If not, the first thing to do is to upgrade your Domino server to a newer version.

These actions are performed via a mail message, which is sent to all users to be migrated. All each user has to do is open this mail message; opening it activates a script that copies the documents. The Notes client is needed to run the script.

As an administrator, you should perform the following steps to migrate the users. The steps are listed here and then described in detail in the following sections.

1. Network mapping
2. Changes to the currently used mail file template (optional)
3. Create a mail file named iNotesConvert.
   a. Create a MailInDatabase document.
   b. Create a new view: iNotesPrep\1. Sent.
   c. Create a new view: iNotesPrep\2. Copied.
   d. Create a subform: iNotesPreparation.
   e. Incorporate the subform into Memo form.
4. Send out the preparation mail
5. Convert mail files to iNotes Mail and C&S

**Networking mapping**

In our scenario, we use drive M as temporary storage for the Notes ID. This has to be unique to the user, otherwise the file could be overwritten. The folder could be in the user's home directory on a file server.

**Changes to the mail file template**

If your users are using Notes R4 mail files, change the SELECT formula for the following views of your Domino server's mail file template:

- ($All)
- ($Drafts)
- Discussion Threads.

Add

```html
& !isavailable(iNotesConvert)
```

to the end of the SELECT formula of each view, as shown in Figure 3-4 on page 51.
This is to hide Business Card, Contact, and Group documents from the user since there is no form for showing them.

![Figure 3-4 View (All) with a modified selection formula](image)

**Create a mail file named iNotesConvert**

This file is used to send mail messages to the users to save their Notes ID file, Personal Address Book, and to merge their documents into their mail file.

Perform the following steps:

1. Create a MailInDatabase document

   In order to receive status messages created by the script, as described in “Sending out the preparation mail message” on page 58, you need to create a Mail-in database document.
2. Create a new view: iNotesPrep\1. Sent

   This view shows all preparation mail messages sent to the users.

   Selection formula for the view:

   `SELECT DeliveredDate = "" & PostedDate != "" & iNotesPrepSent = "1"

3. Create a new view: iNotesPrep\2. Copied

   This view shows all status messages received from users who had opened
   the preparation mail.

   Selection formula for the view:

   `SELECT iNotesPrepDone = "1"

4. Create a subform: iNotesPreparation

   We made all the modifications to a subform that we will insert into the
   standard Memo form later.

   The text field iNotesPrepSent, containing value “1”, is used for the view
   ’iNotesPrep\1. Sent’. 
As soon as the user opens the preparation mail message, the Postopen event script will copy the user's Notes ID file and Personal Address Book to the user's unique network drive, M:\NotesR5 in our example. Then it will copy the Business Card/Contact and Group documents into the user's mail file. In order to copy documents from the Journal database into the user's mail file, the script has to be enhanced further. At the end, a reply message is sent to the iNotesConvert database containing the status, indicating whether the operation succeeded or failed.

Example 3-1  LotusScript used in the Postopen event of the iNotesPreparation subform

Sub Postopen(Source As NotesUIDocument)
   On Error Goto errHandler
   Dim session As New NotesSession
   Dim ui As New NotesUIWorkspace
   Dim uiMemo As NotesUIDocument
   Dim memo As NotesDocument
   Dim reply As NotesDocument
   REM is the data on standard path
   Dim notesPath As String
   REM path and name of the current used id
   Dim notesID As String
   REM network path for the new replica, !!use one per user!!
   Dim newPath As String
   REM define the address of your MailInDatabase
   Dim mailBack As String
   REM does the mail file reside on the server?
Dim isOnServer As String
REM was this job already done before?
Dim copyAlreadyExists As NotesDatabase
REM personal address book
Dim db As NotesDatabase
REM new copy of the personal address book
Dim newCopy As NotesDatabase
REM the currently opened mail database
Dim mailDB As NotesDatabase
Dim col As NotesDocumentCollection
Dim doc As NotesDocument
REM $VIMPeopleAndGroups
Dim viewPG As NotesView
REM those will are business cards or group documents
Dim docPG As NotesDocument
REM it will be the field 'iNotesConvert'
Dim item As NotesItem
notesPath  = session.GetEnvironmentString("Directory", True)
notesId    = session.GetEnvironmentString("KeyFilename", True)
REM drive + path where you want to store the user's ID, the
REM preferrably in a networking drive
newPath = "M:\NotesR5"
REM you should create a MailInDatabase document for this!
mailBack   = "iNotesConvert@iNotesMig"
Set uiMemo = ui.CurrentDocument
Set memo   = uiMemo.Document
REM sender and consignee of the mail have to be different - this is
REM mandatory!!!
If uiMemo.IsNewDoc Or memo.From(0) = session.UserName Then
   Exit Sub
End If
REM just stop if this job has been already done before - don't do
REM this twice
If memo.iNotesPrepDone(0) = "1" Then
   Exit Sub
End If
REM resides the mail file on server?
isOnServer = session.CurrentDatabase.Server
If isOnServer = "" Then
   Set reply = memo.CreateReplyMessage(False)
   reply.Subject = "IWA preparation most likely has failed!"
   reply.Body = memo.SendTo(0) & " has opened the IWA"
   "preparation memo in his local mail file! To cover the users ID " & _
   "and necessary documents from the Personal Address Book only " & _
"will work, when the user’s mail file location is: on Server!" 
Chr(13) & Chr(13) & “Consider it best to send a new IWA preparation mail to the user!"
Call reply.Send(False)
REM we are local - stop and ciao!
Exit Sub

End If
REM if the directory already exists, we'll handle it by the error handler
Mkdir newPath
REM no matter whether the id already exists, we do it again
Filecopy notesPath + "\" + notesID , newPath + "\" + notesID
REM in case the personal address book already exist, we stop now!
Set copyAlreadyExists = New NotesDatabase("", newPath + "\names.nsf")
If (copyAlreadyExists.IsOpen) Then
REM address book already copied - stop and ciao!
Exit Sub
End If

%REM
We copy the private addressbook to the network

We didn’t took type 1. and 2., as ... 
‘... Notes doesn’t like this
1. filecopy notespath +"\names.nsf", "(drive):\names.nsf"
‘... it works, but takes too much time and the user will see it
2. Set replica = db.CreateReplica("", newPath + "\names.nsf")
3. it seems long winded to copy the database without documents ...

%END REM

Set db = New NotesDatabase("", "names.nsf")
If Not db.IsOpen Then Call db.open("", "names.nsf")
Set newCopy = db.CreateCopy("", newPath + "\names.nsf")
REM ... and now to copy the documents...
Set col = db.AllDocuments
Set doc = col.GetFirstDocument()
Do Until doc Is Nothing
Call doc.CopyToDatabase(newCopy)
Set doc = col.GetNextDocument(doc)
Loop

%REM
we’ll gonna merge the Business Cards & Groups from the Personal Address Book into the user's mail file as we do it only once, we don’t prove for duplicate documents - just change the script for a duplicate check

%END REM

Set mailDB = session.CurrentDatabase
Set viewPG = db.GetView("(SVIMpeopleAndGroups)")
Set docPG = viewPG.GetFirstDocument()
Do Until docPG Is Nothing
%REM
a simple way to hide the documents in the R4.x mail file could be, to change the selection formula in the appropriate mail template in the
view: ‘$(All)’ to ‘!@isavailable(“iNotesConvert”)’
%END REM
    Set item = docPG.AppendItemValue(“iNotesConvert”, “1”)
    docPG.iNotesConvert = “1”
    REM the field: ‘iNotesConvert’ to the document
    Call docPG.Save(True, True, True)
    REM copy it to the mail file
    Call docPG.CopyToDatabase(mailDB)
    Set docPG = viewPG.GetNextDocument(docPG)
    Loop
%REM
    ...and finally we are going to send a mail to the MailInDatabase
    we called ‘iNotesConvert’
%END REM
    Set uiMemo    = ui.CurrentDocument
    Set memo      = uiMemo.Document
    Set reply     = memo.CreateReplyMessage(False)
    reply.SendTo = mailBack
    reply.Subject = “IWA preparation - ID and privat N&A have been copied”
    reply.Body    = “User.ID and Private Address Book have been copied “ & _
                   “to the appropriate directory: “ & newPath & “!”
    reply.iNotesPrepDone = “1”
    Call reply.Send(False)
    REM this script will never run again - but only from the eMail!
    memo.iNotesPrepDone = “1”
    Call memo.Save(True, True, True)
    REM now we could tell the user what we did? - we decided not to do so;-)
    REM e. g. (to present this messagebox, remove the single quotation marks)
    ‘Msgbox(“Your system will be upgraded to IWA soon. Therefore your “ & _
            “ID und documents of your Personal Address Book have been saved! - “ & _
            “These documents will be available to you after the upgrade! - “ & _
            “Your NotesTeam”)’
    Exit Sub
errHandler:
    REM if “Path/File access error”
    If Err = 75 Then
        Resume Next
    REM any other error
    Elseif Err > 0 Then
        Resume Next
    End If
End Sub

5. Insert the subform into the copy of the Memo form using the following steps.
   a. Make a copy of the Memo form.
b. Insert the subform at the very beginning of a copy of the standard Memo form.

c. Enable the **Store form in document** attribute of the form's properties, as shown in Figure 3-7.

![Figure 3-7 Form properties for iNotesPreparation Mail form](image)

**d.** Enter **iNotesPreparation Mail** as the name of the form.

**e.** Save and close the form.

**f.** Enable the **Allow use of stored forms in this database** property in Database properties, as shown in Figure 3-8.

![Figure 3-8 Database settings for the iNotesConvert database](image)
Sending out the preparation mail message
Send the preparation message to all users to be migrated.

Figure 3-9 iNotesPreparation mail has been opened by the user

When the user opens the message from the mail file on the server, the script runs and the necessary actions are taken.

You are now ready to convert user's mail files, which is described in the next section.

3.4.3 Converting mail files to iNotes Web Access

Refer to the Domino documentation: Moving to Notes and Domino Release 5 for additional information.

Use the NT prompt and the mail convert utility to convert mail files to the new iNotes Web Access design.

Syntax: nconvert [-r] filename OldDesignName NewTemplateName

The -r switch indicates the change should be done recursively in subdirectories.

Example syntax from the NTprompt:

nconvert -r mail\*.nsf StdR50Mail iNotes5.ntf
where StdR50Mail is the design name. This example replaces all mail files in the data\mail directory that have the design called STDR50Mail with the design that's contained in inotes5.ntf. The -r switch does this recursively for all files in subdirectories of data\mail.

Another example:

```
nconvert mail\*\*\*.nsf * inotes5.ntf
```

This example replaces the design of all files in the data\mail directory with the design in iNotes5.ntf. It does this no matter what the name of the previous design was. When you are done converting mail, send users an upgrade notification message (see 3.5.1, “Deploying iNotes Web Access for online users” on page 60).

It is a good idea to compact and archive all mail databases before you start converting your users. Then convert your users to iNotes Web Access, and after the conversion, rebuild all your views to make sure they are up to date. Table 3-5 shows the server console commands you can use to perform these operations.

**Table 3-5  Commands related to compacting and converting mail files**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>load compact -a mail\*</code></td>
<td>Compact and archive databases in the mail directory.</td>
</tr>
<tr>
<td><code>load convert mail\*\*\* inotes5</code></td>
<td>Convert all databases in the mail directory to the iNotes5 template.</td>
</tr>
<tr>
<td><code>load updall</code></td>
<td>Rebuild views in all the databases on this server.</td>
</tr>
</tbody>
</table>

### 3.5 iNotes Web Access client deployment

When a Domino Administrator is planning an iNotes Web Access deployment, Domino Off-Line Services (DOLS) can be turned on or off.

If you are not planning to have offline users, iNotes Web Access offers a simple deployment model with no-touch desktop installation.

If DOLS is turned on, it will maintain full fidelity of the iNotes Web Access environment on the local desktop. A local installation of DOLS is required on the client side.
3.5.1 Deploying iNotes Web Access for online users

If you are not planning to have off-line users, all you have to do to make iNotes Web Access available to Web browser users throughout the enterprise and beyond is register the users with Domino and send each user an upgrade notification message.

After upgrading mail templates for existing users or creating new mail files using iNotes5.ntf mail template for new users, the administrator just sends users an upgrade notification message with the URL they need to access their mail file. You should ensure:

1. The fully qualified Internet host name (including domain name) must be used to access the mail file. For example, use:

   http://server25.acme.com/mail/mailfile.nsf

   Do not use:

   http://server25/mail/mailfile.nsf

2. Remind users to use their Internet password, since it may be different from their Notes password.

3.5.2 Deploying iNotes Web Access for offline users using DOLS

If you are planning to have offline users, first determine how many of the iNotes Web Access users will require DOLS. Once you determine this number, deploy these users evenly across the available servers to optimize load distribution.

If not already present, DOLS will install the Lotus iNotes Sync Manager on a user's desktop the first time the user goes offline, to provide the conveniences that you would normally find from the Notes R5 Replicator page.

From Lotus iNotes Sync Manager, you can synchronize any changes between the mail file on the server and your offline mail file.

Use the following steps to install DOLS in your environment if you don’t have it installed already.

▶ Enabling DOLS on Domino installation

DOLS can be enabled during Domino installation. To do this, do the following as you are setting up and installing Domino:

a. Click the Customize button for Domino Administrator Server.

b. Check the “Domino Server Program Files” box.

c. Check the “DOLS” box (see Figure 3-10 on page 61).
Figure 3-10  DOLS box on Domino Server installation

- **Upgrading an existing Domino V. 5.05 or newer server without DOLS enabled**
  a. Enable Domino Off-line Services on the target server.
    i. Open the Domino Administrator, open the Server Document for the target server and select the **Internet Protocols/HTTP** tab. (See Figure 3-11 on page 62).
ii. For the DSAPI filter file names field, enter one of values from Table 3-6, depending on your platform.

Table 3-6 DSAPI filter file names

<table>
<thead>
<tr>
<th>Platform</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Win32</td>
<td>ndolextn</td>
</tr>
<tr>
<td>OS/2</td>
<td>idolextn</td>
</tr>
<tr>
<td>AIX</td>
<td>libdolextn</td>
</tr>
<tr>
<td>Solaris Sparc</td>
<td>libdolextn</td>
</tr>
<tr>
<td>OS390</td>
<td>libdolextn</td>
</tr>
<tr>
<td>AS400*</td>
<td>libdolextn</td>
</tr>
</tbody>
</table>

* Note: For the AS/400 platform, the server document will be updated when a new server is configured or an existing server is modified using the CFGDOMSVR or CHGDOMSVR CL command with DOLS(*YES) specified. Refer to the Domino for AS/400 Release Notes for more information on configuring a server with DOLS.
iii. Exit the Domino Administrator.

b. Create and initialize the “Off-line Services” (administration) Database.

i. Open the Notes client.

ii. Create a doladmin.nsf (DOLS security policy) database by choosing File -> Database -> New.

iii. In the New Database window, type doladmin.nsf as a file name, type Offline Services for the Title and use the template “DOLS Administration Template 1.0.” (Figure 3-12).

**Note:** You must check the box labeled “Show Advanced Templates” in order to see the DOLS Administration template.

iv. Specify the target Domino server where DOLS is to be enabled as the name of the “Server” and “Template Server” for the new database.

v. Click OK to create the database.

vi. Choose File -> Database -> Open and open the Offline Services database (doladmin.nsf) created on the target server in the previous steps.

vii. Select the “New Security Policy” option to create one or more DOLS security policies for the target server. The default behavior (if you do not specify a Security Policy) is to prompt end-users to provide ID files when going offline. You can explicitly control and override that default for given security domains by setting to “Automatically generate user IDs” or “Use NAB for ID lookup”.

Figure 3-12 Creating a new DOLS Admin database
c. Shut down and then re-start the target server. DOLS is now available on the server.

Attention: At startup, the console message Domino Offline Services HTTP extension <Release version> loaded should have appeared. If it did, the DSAPI file filter extension field is populated correctly.

▶ Checklist - DOLS installation

a. If you currently use DOLS and are upgrading, make sure Internet Explorer users have deleted the LotusDRSControlClass object.

To delete the LotusDRSControlClass object, open the Internet Options menu, click Settings -> View Objects, right-mouse click the LotusDRSControlClass object, and select Remove from the right-mouse menu.
These steps force the user's browser to upgrade to the new DOLS plug-in or ActiveX components. The first time a subscription is installed from an upgraded server, the client software is automatically upgraded.

b. Make sure users have Internet Explorer 5.01 Service Pack 1 or above installed.

c. Make sure the following are the same:
   - The server's TCP/IP name as registered with the network (on the server document, TCP/IP properties, DNS tab).
   - The server name (on the server document, Basics tab, Server name field).
   - The Internet host name (on the server document, Basics tab, “Fully qualified Internet host name” field).
     For example: acme.lotus.com - “acme” is the machine name, host name for DNS, and Domino server common.

d. Make sure all users have hierarchical names. DOLS does not currently support flat names.

e. If downloading DOLS over a phone line:
   - Open the Server document. At the HTTP tab, change the Output timeout to 300 minutes (Figure 3-15 on page 66) to allow enough time for downloads.
f. Make sure that Anonymous has No Access in all of the Mail files (Figure 3-16).
g. Make sure that the DSAPI filter file name is correct, depending on your platform (Figure 3-11 on page 62), and that you have created a DOLS Security Policy (Figure 3-13 on page 64).

**Note:** To enable users to take the server's directory catalog offline with their mail files, the parameter $DOLSDirectoryCatalog in the server's NOTES.INI file should be set to the name (relative to the data directory) of the directory catalog file for off-line use. If this NOTES.INI parameter does not exist, users will not have the option to take a server directory catalog off-line with their mail files.

**DOLS CD installation**

This installation is preferable for users with large mail files and/or users who access Domino servers using either low bandwidth or dial-up connection.

Once users load the Pre-Installer CD, DOLS will load installation and initial mail file subscription data from a local cache instead of the server connection. You can download the setup files from:

http://www.lotus.com/home.nsf/welcome/offlineservices

The Domino Offline Services CD can contain the client driver filesets and the mail file subscription. The client driver filesets are already installed on the CD. Perform the following steps to add subscriptions and custom filesets:

a. Create replicas of the mail file subscriptions you want to add to the CD.
Any mail file you add to the CD must have the same replica ID as the original. You cannot make a “new copy” using the Notes client, since new copies have new IDs.

You can create a “stub” mail file for the CD, meaning only the design elements are added. To create a stub mail file, make a replica of the database containing only the design elements. During the user’s first synchronization, the documents will be added.

b. In the directory \Contents\Subscriptions on the CD, create one folder for each subscription. Name each folder with the replica ID of the main database of the subscription. For example:

\Contents\Subscriptions\72638271927F46D8

**Note:** There is a hidden field in the Profile document which contains the database replica ID.

c. In each subscription folder, add the subscription in a directory structure exactly matching the subscription’s directory structure on the Domino server. For example, if the DOLS-enabled mail database joe.nsf was located in \Data\Mail on the server, then you’d add the following to the CD:

\Contents\Subscriptions\72638271927F46D8\Mail\joe.nsf

d. If you want to use a directory catalog off-line, create a Directory Catalog folder under \Content\Subscriptions\<replica id> and add a replica of the catalog.nsf. For example:

\Content\Subscriptions\72638271927F46D8\DirectoryCatalog\nameofcatalog.nsf

**Note:** If the Directory Catalog is an optional file, in the Offline Configuration Document of the online mail file (Figure 3-17 on page 69), the “Automatically replicate new DBs” check box in the Optional Files to Replicate section must be checked for the file to be replicated the first time. Another option (recommended) is to set a default directory catalog by adding $DOLSDirectoryCatalog=nameofcatalog.nsf to the notes.ini on the server. If you set a default, it is installed with every subscription unless you specify a different catalog in the Directory Catalog file name field.
To create a custom program

To create a custom program to run immediately after install, create a file called dolscontent.ini in the directory \Contents on the CD. Make the first line [DOLS]; the second line SetupProgram=; and the third line SetupCommandLine=. Add the name of any programs you want run to the SetupProgram= line. Add any specific commands you want to the SetupCommandLine line.

For example, if the first thing you want to happen after install is for the user's Explorer browser to open to the URL of the application “foo,” add the following to dolscontent.ini:

```
[DOLS]
SetupProgram=explorer.exe
SetupCommandLine=http:\www.foo.com
```
- **Working offline**

  After DOLS installation, working offline allows users to access the information in their mail files when their computers are not connected to a network. When you work offline, you can create messages, schedule meetings, respond to e-mail, and do most of the same things you can when you are online.

  **Note:** When working with folders offline, you need to refresh your browser when returning online to see the newly added, changed, or deleted folders.

To work offline, click **Go Offline** on the task bar while in iNotes Web Access. This will give you access to a **Go Offline** button; click this button (Figure 3-18) for a menu of options.

![Go Offline menu options](image)

If this is the first time you go offline, you are prompted to install iNotes Web Access as a subscription on your local machine, and also to install Lotus iNotes Sync Manager. A subscription includes your mail file, help, related databases, and property settings. If download time is an issue, you can also use a CD-ROM to install the Lotus iNotes Sync Manager (see “DOLS CD installation” on page 67).
The Lotus iNotes Sync Manager installation will prompt you for the name of a new folder in which to install Lotus iNotes (Figure 3-19).

![Folder name to install Lotus iNotes Sync Manager](image)

*Figure 3-19  Folder name to install Lotus iNotes Sync Manager*

While installing the subscription, you may be prompted for your Notes ID (Figure 3-20), depending on the offline security policy settings on the server, which were described previously.

![Prompt for Notes ID](image)

*Figure 3-20  Prompt for Notes ID*

**Note:** If you are a Notes client user, you can use your regular Notes ID file, usually stored in the `\notes\data` directory.
Once the download finishes, Lotus iNotes Sync Manager opens automatically (Figure 3-21).

![Lotus iNotes Sync Manager](image)

Figure 3-21 Lotus iNotes Sync Manager

Lotus iNotes Sync Manager is integrated into the Windows desktop and lets you manage multiple offline subscriptions. With Lotus iNotes Sync Manager, you can perform the following tasks:

- Open iNotes Web Access offline to use as if it were online and connected to a network server.
- Set standard synchronization settings including schedule and frequency.
- Synchronize the online and offline versions of iNotes Web Access with each other.

If you want to look up mail addresses or send meeting invitations while working offline, it's recommended that you include the server's name and address book or directory catalog when you go offline. Make sure this preference is enabled.

**Restriction:** You cannot change spelling dictionaries when you are working offline. When offline, your spelling dictionary is set by the default language selected on the server.

### 3.6 Uninstalling iNotes Web Access client

Follow these steps to uninstall iNotes Web Access:

1. Delete the upload control in your browser's object cache.
   a. Open your Internet Explorer browser.
   b. Select **Tools -> Internet Options** from the menu.
c. Under “Temporary Internet Files”, click **Settings**.

d. Click **View Objects**.

e. Right-click the file **iNotes Class** and from the context menu, select **Remove** (Figure 3-22). If you used iNotes Web Access to go offline, then also right-click on the file **LotusDRSControl Class** and from the context menu, select **Remove** (Figure 3-14 on page 65).

![Figure 3-22 Remove iNotes Class](image)

f. Close the Object Window, click OK, then click OK again.

2. Remove the temporary iNotes Web Access files from your browser's cache:
   
   See 2.5.1, “How to manually delete temporary Internet files” on page 30.

3. If you have launched any attachments, an iNotes Web Access directory has been created as a subdirectory of your system TEMP directory, for example, \c:\temp\iNotes Web Access. Remove this directory. The directory is automatically removed if the iNotes Web Access version you are using is 5.0.9 or later.

4. Uninstall Domino Offline Services (DOLS) client software, also known as “Lotus iNotes.”
   
   This step is necessary only if you went offline with iNotes Web Access.

   a. From the Windows **Start** menu, select **Programs -> Lotus iNotes**.
   
   b. Select **Uninstall Lotus iNotes**.
   
   c. Click the **Uninstall** button (Figure 3-23 on page 74).
d. Click **Yes** (Figure 3-24).

3.7 Directory Assistance and Directory Catalog

iNotes Web Access can use other directories made accessible through configured Directory Assistance on the Domino server. Within the Select Addresses dialog box you can search and find people from all directories defined in Directory Assistance and also from the Directory Catalog.
Figure 3-26  Find & Search within Domino directory

For more information about Directory Catalog, and how to configure the Domino server for Directory Assistance, refer to the *Domino Administration Help* database (help5_admin.nsf).

### 3.8 Welcome page

The Welcome page is designed to be fully customizable, to easily meet the needs on a per-user level, a group level, or even an organization-wide level. To deploy customized Welcome pages for groups or subgroups, each server will maintain a single “uniquely customized” Welcome page. A Server Configuration Document in the Domino Directory can be used to configure the unique Welcome page on a per-server basis. To provide an organization-wide Welcome page, just complete the information on the iNotes Web Access tab in the " - [all servers] Server Configuration Document.

**Note:** If an iNotes Web Access user specifies a Personal Page Layout as their Welcome page, that setting takes precedence over the setting the Domino Administrator has configured in the Server Configuration Document.

Figure 3-27 on page 76 and Figure 3-28 on page 77 show an example of how to set up the Welcome page URL and Welcome page title on the iNotes Web Access settings in the server configuration document.
Figure 3-27  iNotes Web Access settings in the Server Configuration Document
Figure 3-28 Welcome page deployed by the server

Note: If you set a default URL and are running Internet Explorer 5.01, the default page pane hides some of the submenus in iNotes Web Access. This is caused by a limitation in Internet Explorer 5.01. You can see all the submenus if you are using Internet Explorer 5.5.

Note: As with Domino 5.0.9, you have to be careful which characters you’re using for the title. For example, the use of a single quotation mark may cause the browser to show pages incorrectly or result in a series of errors.

3.9 Server deployment - quick reference

The following steps identify how to easily set up iNotes Web Access for an existing environment:

1. Plan for capacity.

Refer to Chapter 4, “Scalability and performance” on page 79 to determine the required number of servers to support your organization size.
2. Install or upgrade software.

Install Domino server, version 5.0.8 or newer, on the required number of servers. If you are upgrading an R4 server, refer to the redbook *Lotus Notes and Domino Take Center Stage: Upgrading from R4 to R5*, (SG24-5630).

3. Verify the correct server settings.

See 3.3, “Server configurations” on page 44.

4. Enable the HTTP server task.

See 3.3.3, “HTTP task” on page 47 and refer to the *Domino 5 Administration Help* for more details.

5. Plan offline support and enable DOLS on each server that will be supporting users for off-line access.

See 3.5.2, “Deploying iNotes Web Access for offline users using DOLS” on page 60.

6. Create new user accounts using the iNotes Web Access design template *(inotes5.ntf)* or convert existing users.

See 3.4, “Migration of users” on page 48.

7. Pre-configure a Welcome page.

See 3.8, “Welcome page” on page 75.

8. Notify online and offline users with instructions.

See 3.5, “iNotes Web Access client deployment” on page 59.
Chapter 4. Scalability and performance

This chapter provides information to help you size, configure, and tune a Domino server for optimal performance and scalability when using iNotes Web Access clients. Our design guidelines include requirements for server scalability, capacity, performance, network utilization, high availability, and response times.

In this chapter, the following topics are discussed:

- Capacity planning
- Client/server performance and scalability
- Server performance
- Adding DOLS to improve server scalability
- Clustering
- Hardware configurations
- iNotes Web Access to WebMail comparison
- Network bandwidth utilization
4.1 Scalability and capacity planning

One of the main goals for iNotes Web Access is to provide a faster performing, better scaling, yet fully functional Web client. Internal benchmarks demonstrate that this goal was significantly achieved.

This section provides information that will help you to size your iNotes Web Access environment. Trying to size a server to be the best for your environment is usually a complicated task. In this section we provide guidelines for this task, show you the results of some internal tests, and point you to other sources for specific information related to your environment.

4.1.1 Hardware sizing tools

A number of helpful sizing tools are available on the Web. These tools can help you determine which kind of server would be best for your environment. You can specify your preferences, such as number of users, concurrent users, type of users, hardware preferences, and the tools analyze you requirements to help you find the best server for your organization.

These tools are provided by hardware vendors. The tools are often developed by the same individuals who conduct NotesBench testing and who also help customers size Domino and iNotes Web Access deployments.

Sizing tools are available for the following products:

- IBM xSeries (Netfinity) servers
  http://www.developer.ibm.com/welcome/myvc.pl
- IBM iSeries (AS/400) servers
  - IBM Workload Estimator for AS/400 Servers
    http://as400service.ibm.com/estimator
  - Domino for AS/400 Application Sizing Examples
    http://www.as400.ibm.com/domino/d4appsz.htm
- IBM zSeries (S/390) servers
  - Processor Capacity Reference (PCR) tool
    http://w3.ibm.com/support/wsc
    (Click S/390 - Capacity Planning - Tools - PCR)
- IBM pSeries (AIX) servers
  - Server Planning database - Lotus Sales Tools 5 ()
  - Server Planning database - Web site
For more information about sizing tools, refer to the Domino Performance Zone at http://www.lotus.com/performance.

### 4.1.2 Tools used for measuring server performance: NotesBench

NotesBench for Lotus Notes is a collection of benchmark workloads that simulate the behavior of Domino workstation-to-server or server-to-server operations. Using NotesBench, vendors and other organizations evaluate the performance of various Domino and Notes platforms and configurations. Lotus provides NotesBench to hardware vendors and qualified Lotus Business Partners. Using the tool, vendors and business partners generate benchmark information, which they can distribute to their customers. In turn, customers can use the benchmark information to evaluate vendors, select configurations, and plan resource budgets.

To use NotesBench, you must be a member of the NotesBench Consortium, which is an independent, non-profit organization dedicated to providing Domino and Notes performance information to customers. The consortium requires that each member run the NotesBench tests in the same manner and allow tests to be audited. You can visit the NotesBench Web site at:

http://www.notesbench.org

A NotesBench workload for iNotes Web Access has been created and supplied to members of the NotesBench Consortium. Members have committed to providing audited NotesBench reports for iNotes Web Access in the near future.

NotesBench is considered a standard for Domino benchmarking and the results of these benchmarks can also be found on www.ideasinternational.com along with other industry standard benchmarks.

### 4.1.3 iNotes Web Access server performance tests

The IBM Westford Lab performance team did some internal scalability benchmarks for iNotes Web Access. The goal of these tests was to simulate iNotes Web Access usage on a tested configuration.

The iNotes Web Access messaging workload used in this test was:

- On Nth iteration (Usually 6th iteration which is every 90 minutes)
  - Create a new Message
b. Add 3 recipients

c. Submit message

Every iteration (every 15 minutes)

a. Open Inbox

b. Read 1st message
c. Delete 1st message
d. Read 2nd message
e. Read 3rd message
f. Read 4th message
g. Read 5th message

Note: The messaging workload did not do any actions related to calendaring and scheduling.

The purpose of these benchmark tests is to demonstrate platform scalability and resource utilization in specific workloads. The test was not meant to compare different platforms. Information from the tests can be used as a guideline for capacity planning purposes.

Results of the peak benchmark tests

The tests were performed on two platforms with two different configurations.

IBM eServer pSeries S80 running AIX 4.3.3

<table>
<thead>
<tr>
<th>Number of CPUs (400 MHz each)</th>
<th>Memory</th>
<th>Number of users</th>
<th>Response time in seconds</th>
<th>% CPU utilization</th>
<th>% CPU/user</th>
<th>Transaction/minute</th>
<th>Transactions/user</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>16 GB</td>
<td>5850</td>
<td>0.255</td>
<td>95</td>
<td>0.033</td>
<td>3469</td>
<td>0.59</td>
</tr>
<tr>
<td>4</td>
<td>4 GB</td>
<td>2500</td>
<td>0.781</td>
<td>98</td>
<td>0.039</td>
<td>1500</td>
<td>0.60</td>
</tr>
</tbody>
</table>

Table 4-1 Results of scalability test on pSeries platform

Data on two SSA loops with 165 9 GB drives, each configured as one RAID 0 Logical unit.

IBM Netfinity 5500 M20 running Windows2000 SP1

<table>
<thead>
<tr>
<th>Number of CPUs (550 MHz each)</th>
<th>Memory</th>
<th>Number of users</th>
<th>Response time in seconds</th>
<th>% CPU utilization</th>
<th>% CPU/ User</th>
<th>Transaction/minute</th>
<th>Transactions/ user</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>2.5 GB</td>
<td>4500</td>
<td>0.534</td>
<td>90</td>
<td>0.02</td>
<td>2654</td>
<td>0.59</td>
</tr>
<tr>
<td>4</td>
<td>2.5 GB</td>
<td>2500</td>
<td>1.000</td>
<td>79</td>
<td>0.031</td>
<td>1463</td>
<td>0.59</td>
</tr>
</tbody>
</table>

Table 4-2 Results of scalability test on Windows2000
Data on three EXP 200 9 9 GB drives, each configured as one RAID 0 Logical unit (for the 8-way). Data on two EXP 200 9 9 GB drives, each configured as one RAID 0 Logical unit (for the 4-way).

All tests showed less than 1 second response time. A response time equal to or less than 1 second is considered acceptable. The number of users is increased by 250 until the response time is over 1 second. This result is then discarded and the previous one is used for final results.

A performance test on the iSeries platform
Table 4-3 shows results from tests the iSeries Domino performance team made with iNotes Web Access on an iSeries platform. The purpose of these tests was to look at various tuning capabilities and settings. Note that this was not a peak performance test, and therefore it is not comparable to tests in the previous section. Rather, the goal was to generate sizing data, with a workload that is running at 70 to 80 percent CPU capacity, that is not constrained by factors such as network, disk, or main store (memory).

If fact, the data obtained from these tests was used as input for the iSeries sizing tool, the Workload Estimator. (See 4.1, “Scalability and capacity planning” on page 80.)

The following measurement information was collected on an iSeries model 820-2438 running OS/400 V5R1. This system would have performance equivalent to the Dedicated Server for Domino (DSD) model 820-2458. The system was configured with 43 9 GB disk drives and RAID5 protection.

<table>
<thead>
<tr>
<th>Number of CPUs (600 MHz each)</th>
<th>Memory pool size</th>
<th>Number of users</th>
<th>Response time in seconds</th>
<th>Average CPU utilization</th>
<th>Average disk busy utilization</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>3.1 GB</td>
<td>2000</td>
<td>0.133</td>
<td>77%</td>
<td>1.0%</td>
</tr>
<tr>
<td>4</td>
<td>1 GB</td>
<td>2000</td>
<td>0.214</td>
<td>79%</td>
<td>6.3%</td>
</tr>
</tbody>
</table>

4.1.4 Mixed workload tests
The mix of Notes clients and iNotes Web Access clients in your user community has a big impact on actual server workload.

The IBM Westford Lab performance team conducted tests with a variety of mixed client workloads. Testing was done on an IBM Netfinity 4-way 500 MHz Server with 2.5 GB of memory and two 9-disk exp15 RAID 0 Arrays for the data.
Workloads used were the iNotes Web Access messaging workload (described previously) and the R5Mail workload. (A description of the R5Mail workload is on the NotesBench Web site.)

Benchmarks were run with 100% R5Mail (Notes R5 Client) simulated users, 100% iNotes Web Access simulated users, and a 75/25 and 50/50 Notes R5 Client to iNotes Web Access user load. This was not a maximum users test, but instead testing on a reasonably loaded server to see the effect of different mixes of clients.

The following results were obtained for the specific workload and configuration:
- With 100% simulated iNotes Web Access users there were 2000 total users.
- With 50% simulated iNotes Web Access users and 50% simulated R5Mail users there were 4000 total users.
- With 25% simulated iNotes Web Access users and 75% simulated R5Mail users there were 5000 total users.
- With 100% simulated R5Mail users there were 6000 Total users.

4.2 Client/server performance and scalability

In this section we explain why iNotes Web Access shows improved performance on both client- and server-side.

4.2.1 Client-side

There are several things that impact client performance, including:
- The number of total bytes downloaded from the server to the browser for the page
- The complexity of server-side formulas and logic to generate the page
- The total number of files that comprise the page
- The HTML and client-side logic needed to generate the page

To boost client performance, the code is separated from the data as much as possible. In this manner, most of the code is broken up into external script files, which are downloaded once and then very efficiently cached within the browser's temporary Internet files folder. The JavaScript code is also streamlined to minimize page size and boost performance. There is also extensive use of
cascading style sheets to reduce the size of the HTML and minimize the sizes of bitmaps on the page. In many situations, the need to reload an entire page is minimized by getting only the new data necessary and rebuilding the HTML with client-side code.

There is no JavaApplet used with iNotes Web Access itself. Only when you are using the chat functionality (via the Chat button) will a Sametime Java Applet be loaded.

To allow a more Windows-like experience manipulating attachments (drag and drop), a custom ActiveX upload control is used.

If you opt to go off-line with DOLS, another ActiveX component will be used by DOLS to communicate the off-line state and interact with the Lotus iNotes Sync Manager.

4.2.2 Server-side

Factors impacting server-side scalability include things like:

- The amount of disk access required to generate a page
- The amount of server-side computation required to generate a page
- The amount of contention among server threads processing separate requests
- The number of requests received from each user

To boost server-side scalability, lots of server-side caching of forms and subforms across all users on the same server is employed (Forms5.nsf). Traditional Domino Web applications have forms and subforms in each and every end user database that are not cachable across multiple users. Further, many of the static external files within a Web page are set up to be very efficiently cached by the browser. This should reduce the amount of requests to the server as a user continues to use the application. Lastly, there is caching of certain data to minimize the computation required to generate subsequent pages and boost both client- and server-side performance.

4.3 Configuring your server for performance

This section describes ways to increase the performance of iNotes Web Access servers by changing or fine-tuning Domino settings to suit your environment.

In this section we cover:

- Configuration and tuning
4.3.1 Configuration and tuning

This section describes platform-specific settings and configurations to achieve optimum performance on your server.

**Windows 2000 Professional, Server, Advanced Server**

We suggest the following configuration changes to optimize Windows 2000:

- **Multitasking**
  - Control Panel - System - Performance - Application Performance >> Boost = None

- **Paging File**
  - Control Panel - System - Performance - Virtual Memory - Change:
  - Create a new paging file on a separate disk drive with the minimum and maximum size = RAM + 10%. Note that the paging file should be on its own disk drive. We generally recommend that you do not place it on the same disk drive as your operating system, Domino data files, or Domino transaction log. Delete the existing paging file on disk C.

**Windows NT Server 4.0 SP4 and above**

We suggest the following configuration changes to optimize Windows NT:

- **File Cache**
  - Control Panel - Network - Services - Server - Properties >> Maximize

- **Multitasking**
  - Control Panel - System - Performance - Application Performance >> Boost = None

- **Paging File**
  - Control Panel - System - Performance - Virtual Memory - Change:
Create a new paging file on a separate disk drive with the minimum and maximum size = RAM + 10%. Note that the paging file should be on its own disk drive. We generally recommend that you do not place it on the same disk drive as your operating system, Domino data files, or Domino transaction log. Delete the existing paging file on disk C.

**IBM @server pSeries (AIX)**

The following information was provided by the IBM @server pSeries server organization. Further information may be found at:

http://www.ibm.com/servers/eserver/pseries/

Server tuning settings can dramatically impact performance. Administrators tuning an AIX server for iNotes Web Access should follow these steps:

1. In the Domino server document, define maxactivethreads n, where n = [40/no_of_processors].
2. Restart the server.
3. Verify the correct value by inspecting the “MaxActiveThreads” value displayed by the Domino show stat command. (It will show maxactivethreads * n-processors.)
4. Run your Domino Web server under load.
5. As your server runs, monitor the CPU run length. It is the value in the first column of the `vmstat` command. A run length of 4 is optimal. If the value is too high, lower the maxactivethreads value by 1 and re-test. If your run lengths are lower than 4, you can try increasing maxactivethreads.

**Sun Solaris**

For performance optimization and tuning tips for Domino Server on Sun Solaris, refer to IBM Redbook *Lotus Domino R5 for Sun Solaris*, SG24-5969.

**IBM @server iSeries — OS400**

The following information was provided by the IBM @server iSeries server organization.

For the iSeries platform, we recommend specifying `NSF_BUFFER_POOL_SIZE_MB`. This is because the Domino servers run out of their own storage pool, which is typically changed dynamically by the auto-performance adjuster (WRKSYSVAL QPFRADJ).

If you do not set `NSF_BUFFER_POOL_SIZE`, Domino will calculate a value to use based on the total memory of your AS/400, not on its share of the storage pool. 300 MB will probably work fine for most servers, but a better value would be determined as follows:
a. Find which storage pool the server is running out of. You can find this from WRKACTJOB; default is pool 2.

b. Find the size of the pool while your system is running at steady state (that is, when QPFRADJ isn’t changing the pool sizes). You can see this with WRKSYSSTS.

c. If you have multiple partitioned servers using that pool, divide the pool size by the number of servers using the pool (excluding the *HTTPSETUP server) and multiply by 3/8. Set NSF_BUFFER_POOL_SIZE_MB in NOTES.INI to this number.

We generally recommend that you enable “run Web agents concurrently” in the Server Document (under Internet Protocols/HTTP) for most Web applications, including WebMail and iNotes Web Access.

**Sizing Recommendations for iSeries**
The IBM Workload Estimator for iSeries provides sizing recommendations for an iSeries or an AS/400e running one or more workloads associated with e-business and/or collaboration, such as Domino, Java, or WebSphere. You can use the Estimator to size a brand new iSeries or AS/400e with all new workloads, or to size the upgrade of an existing system (with the original workload set or any additions) to a new system. Support for sizing iNotes Web Access mail users was recently added to the Estimator, which also supports sizing with Notes, WebMail, POP3, IMAP, and iNotes Access for Microsoft Outlook clients, and Domino applications. The Estimator can be accessed at:

http://as400service.ibm.com/estimator

**For further information**
Further information may be found at:

**IBM @server zSeries — OS/390**
Tune the Domino settings for your environment as you would for the other platforms. In particular:

- Take the default value for the number of HTTP threads (40) as recommended previously.
- Take the default for the Notes_SHARED_DPOOLSIZE environment variable, which is 8 MB. Our testing has shown this to be an optimal value for the Domino server in general.
- Explicitly set NOTES_SHARED_DPOOLSIZE_MB to a value between 256 and 768. Domino will not default this value to a percentage of available central storage on this platform, so you will need to do this yourself. Start at the low end of this range, and increase as needed. If you think you need more than
768 MB for the shared dpool size, it's time for you to start planning for an additional Domino partition.

From a platform standpoint, follow all of the usual guidelines. These are documented in detail in the performance redbook, *Lotus Domino for S/390 Release 5: Performance Tuning and Capacity Planning*, SG24-5149. When planning for an iNotes Web Access configuration, keep in mind that I/O to disk and the network will be significantly higher than when serving traditional Notes clients. The server will be more sensitive to non-optimal DASD and network configurations. Take extra care to spread DASD activity over several volumes, ensure that controllers are caching properly, and that there is enough channel bandwidth to the DASD devices. Above all else, monitor the SMF and Domino data from your environment to look for bottlenecks, particularly early on in your deployment. For other information regarding Domino server performance in general, see:


### 4.3.2 MAIL.BOX Configuration

For optimal messaging throughput, start with two MAIL.BOX files enabled. It is important to recognize that MAIL.BOX grows as messages queue—and this growth can potentially impact Disk I/O operations. Therefore, it is important to monitor MAIL.BOX statistics on the Domino server. Check statistics like Mail.Waiting and Mail.MaximumDeliverTime. If either or both statistics increase over time, you should increase the number of active MAIL.BOX files.

### 4.3.3 Tuning network timeout values

When a Web browser makes a request to a Domino HTTP server process, the following occurs:

1. A thread is opened.
2. When the request is fulfilled, the thread becomes idle, but remains open.
3. If all available threads are in use, the server will buffer the transaction request until a thread is free.

Open, inactive sessions can prevent users from accessing your Domino servers. By specifying appropriate time limits for activities between the Domino Web server and clients or CGI programs, you can ensure that connections don’t remain open if there is no network activity between them.

The settings described in Table 4-4, which appear on the **Internet Protocols - HTTP** tab in the Server document, allow you to fine-tune your network timeout values.
Table 4-4  Network timeout settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input timeout</td>
<td>The time that a client has to send a request after connecting to the server. The server uses this field if the client that is connected to the server is not sending “keep alive headers” to the server within the amount of time specified. Many current versions of browsers send keep alive headers and do not need to use the Input timeout setting. Use this setting if you have clients connecting to the server using browsers that are not current versions.</td>
</tr>
<tr>
<td>Default = 2 minutes</td>
<td></td>
</tr>
<tr>
<td>Output timeout</td>
<td>The maximum time that the server has to send output to a client. This field applies to local files and requests. The time limit does not apply to requests that start a local CGI program. If the server does not send the complete request within the amount of time specified in the Output timeout field, the server drops the connection.</td>
</tr>
<tr>
<td>Default = 20 minutes</td>
<td></td>
</tr>
<tr>
<td>CGI timeout</td>
<td>The maximum time that a CGI program started by the server has to finish. When the time specified in this field runs out, the server sends a message to the CGI program. After five minutes, the server shuts down the program.</td>
</tr>
<tr>
<td>Default = 5 minutes</td>
<td></td>
</tr>
<tr>
<td>Idle thread timeout</td>
<td>No effect, remains in the Server document for backward compatibility only.</td>
</tr>
</tbody>
</table>

Following are some general guidelines for setting the timeout values identified in the table:

- The default value of 0 (zero) for the “Idle Thread Timeout” setting means that an idle thread will be kept open indefinitely. Setting this to 5 or 10 minutes may improve performance on slower servers, or in high-traffic situations. It can also help boost performance for some applications that people may log into and then not actually use for long periods.
- If users report input timeout errors, raise the “Input Timeout” value. This can be a common problem over dial-up connections; it most typically manifests when a user submits a form after it has been open for editing for a while.
- A frequent cause of output timeout errors is insufficient cache directory size, or insufficient system memory to handle multiple requests. Output timeouts can also occur over slow modem connections when downloading or requesting a large file.
- Make sure you know how long it takes your CGI scripts to execute before you tweak the “CGI Timeout” value. (The default is five minutes.) If there are many external processes to run, additional time may be required.
4.3.4 Optimizing HTTP thread settings

Domino R5 allows you to specify the number of threads the HTTP server can process, as well as the number of requests a user can make over a single connection to the server. These settings effectively limit the number of users who can access the server simultaneously—obviously a big factor in scalability and performance. Hence it’s often worthwhile to customize these defaults to fit the servers in your environment. If the maximum number of active threads is reached, Domino queues new requests until a request finishes and more threads become available. The more processing power a system has, the greater the number of threads it can support. Conversely, if a server is spending too much time on overhead-related tasks, such as swapping memory, you probably need to lower the maximum number of threads it can process.

You can experiment with the values. However, we recommended that you keep the default values for these fields. Changes to these values were tested on various configurations and platforms; the results of the tests showed that the best performance is reached with default values.

Table 4-5 describes the thread configuration settings available to you; they appear on the Internet Protocols - HTTP tab of the Server document.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number active threads</td>
<td>The number of threads that can be active on the server at the same time. The default is 40.</td>
</tr>
<tr>
<td>Minimum active threads</td>
<td>The field has no effect on Domino R5. It remains in the Server document for backward compatibility.</td>
</tr>
<tr>
<td>Maximum requests over a single connection</td>
<td>The number of requests a browser can make to the server at the same time. The default is 1. This setting affects browsers compatible with HTTP 1.1 or later, if the browser includes the capability to send multiple requests to a server without waiting for a reply from the previous request. For more information, see the documentation for your browser.</td>
</tr>
</tbody>
</table>

4.3.5 Minimizing view rebuild times

A Domino server can perform view rebuild operations as much as five times faster when you designate a separate drive where Domino can write the temporary files it creates when it rebuilds views. The greater the space available on the dedicated drive, the greater the increase in rebuild speed. If your servers are running up against space constraints in this critical area, you might see a message like the one shown in Example 4-1.
Example 4-1  Warning message - View rebuild

06/20/2001 01:13:55 PM Warning: unable to use optimized view rebuild for Viewname due to insufficient disk space at C:\TEMP. Estimate may need 1045 million bytes for this view. Using standard rebuild instead.

This message indicates that Domino was unable to rebuild the view in the space available (in this case, in \TEMP, the default) using R5’s highly optimized view rebuild task. Instead, it reverted to the slower R4 rebuild task. To specify a path to a dedicated (or roomier) drive, place a command in NOTES.INI of the form:

```
view_rebuild_dir=X:\pathname\n
```

Note that the disk space R5 needs to rebuild a view can be much larger than the actual view size as specified when a user selects View Properties. Therefore, depending on how big your views are in the first place, you may want to take a little time to evaluate how much disk space you’ll actually need to allocate.

More view rebuild tips

It’s worth noting in this context also that:

- R5 can spawn a separate indexing thread for each CPU, on servers with multiple CPUs. This capability better leverages a multiprocessor platform, and improves performance; especially for the drive where Domino writes temporary files during view rebuild operations.

- Views that don’t require frequent updates can, and should, be reindexed less frequently. For example, the view of an archive where documents come and go as a result of batch processes can probably be indexed once a day. Depending on your servers and applications, a few such tweaks could make a considerable difference.

4.3.6 Reconfigure server cache settings

One way Domino optimizes performance is via an in-memory cache, where it stores information about HTTP commands, database designs and/or users. Caching this kind of information saves the time required to process or recreate it, and these settings can have a big impact on Web application performance. The more information you can cache, the better the HTTP server can perform for users. We know of no threshold beyond which cache size does not improve performance.

You can fine-tune how much of each type of information is cached, in line with available server memory resources. In the HTTP Server section of the Server document, change the settings described in Table 4-6 to adjust a server’s memory cache.
### Table 4-6 HTTP settings on server document

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum cached commands</td>
<td>The number of HTTP server commands to cache for anonymous users. Domino must convert some HTTP server commands, such as OpenDatabase and OpenView, to HTML before the server can process the commands. This conversion process takes time. Use this field to specify how many commands you want to store in memory so the next time a user issues the server command, it is immediately available.</td>
</tr>
<tr>
<td>Default = 128</td>
<td></td>
</tr>
<tr>
<td>Maximum cached designs</td>
<td>The number of database design elements to cache for users. When a user opens a database, Domino maps each design element name to an identification number. This mapping procedure takes time. Use this field to specify how many elements you want to store in memory so the next time a user accesses that element, it is immediately available.</td>
</tr>
<tr>
<td>Default = 128</td>
<td></td>
</tr>
<tr>
<td>Maximum cached users</td>
<td>The number of users to cache. After a user successfully authenticates with a server, Domino stores in memory the user’s name, password, and the list of groups to which the user belongs. Use this field to increase the number of users for whom Domino stores this information.</td>
</tr>
<tr>
<td>Default = 64</td>
<td></td>
</tr>
<tr>
<td>Cached user expiration</td>
<td>The time interval in seconds during which Domino regularly removes user names, passwords, and group memberships from the cache. You should remove user names, passwords, and groups memberships from the cache periodically to force Domino to look up user credentials in the directory the next time they access the server.</td>
</tr>
<tr>
<td>interval</td>
<td>Default = 120</td>
</tr>
</tbody>
</table>

You'll need to evaluate for yourself what values work best for each of these settings. It's a “tweak as you go” proposition, while keeping an eye on your server statistics. One trial-and-error evaluation method is to double a value until you see a degradation in performance, and then lower it from there.

### 4.3.7 Optimizing Domino server task priorities

In most situations, the operating system runs many Domino tasks; however, only one or two of them require a higher priority than the rest. For those running Domino on platforms other than Windows NT, such as IBM AIX or OS/400, you can alter the priority of certain Domino tasks to improve performance.
There are several situations where changing the priority can boost overall server performance. Lotus recommends you consider increasing the priority of http and server tasks relative to others for iNotes Web Access servers.

The commands for altering a process’s priority are system specific. On AIX, for example, the command `renice` is used; it can be executed only by the root user. Since Domino servers are started from user accounts other than root, AIX customers will need to take extra steps to automatically reconfigure the priorities for Domino server tasks at startup time. (This may be true on other platforms as well.)

4.4 Adding DOLS to improve server scalability

iNotes Web Access is fully functional offline and users can take advantage of that. Among other things, users can read e-mail, write e-mail, and use their calendars offline, and synchronize with the server at off-hours when traffic to the server is light.

If users have expensive and slow connections to the Domino server, the advantages of using Domino Off-Line Services are obvious. Users save both time and money by working offline.

Even when users have fast or inexpensive connections to the Domino server, working offline has advantages for the server. By reducing traffic to the server, you make the server more efficient and more cost-effective.

Using iNotes Web Access offline has another big advantage. When your users are not using their mail files on the server, the network bandwidth consumption is decreased.

4.5 Reliability with Domino clustering

You can set up your iNotes Web Access Servers to work in a cluster, to ensure high availability and performance and to balance the workload between servers.

4.5.1 A Domino cluster defined

A Domino cluster is a group of servers that lets you provide users with constant access to data, balance the workload between servers, improve server performance, and maintain performance when you increase the size of your enterprise. The servers in a cluster contain replicas of databases that should be readily available to users at all times. If a user tries to access a database on a
cluster server that is not available, Domino opens a replica of that database on a
different cluster server, if a replica is available. Domino continuously
synchronizes databases so that whichever replica a user opens, the information
is always identical.

4.5.2 Internet Cluster Manager - ICM

The Internet Cluster Manager (ICM) lets you use Domino clusters to provide
failover and workload balancing to HTTP clients (Internet browsers) when they
access Domino Web servers. This makes your iNotes Web Access servers
highly available to clients. You can run the ICM on any server that is using the
Domino Release 5 Enterprise Server license. You install and configure Domino
clusters as you normally would, and then you configure the ICM. The ICM
supports the HTTP and HTTPS protocols.

The ICM acts as an intermediary between HTTP clients and the Domino Web
servers in a cluster. When Domino Web servers are running in a cluster, they
generate URLs that direct HTTP client requests to the ICM. The ICM maintains
information about the availability of servers and databases in the cluster. When
the ICM receives a client request, it redirects the client to the most available
server that contains a replica of the requested database.

The ICM sends periodic probes to the Web servers in the cluster to determine
their status and availability. When the ICM receives a client request, it looks at
the information in the Cluster Database Directory to find a server that contains
the requested database. The ICM determines the most available server that
contains the requested database, and then redirects the client to that server. This
results in the client closing the session with the ICM and opening a new session
with the selected server. The user may see this as a change in the host name in
the URL. The user may also see the path to the database change in the URL
because the database may have a different path on the target server.

Configuring the ICM

You configure the ICM by making entries in the Internet Cluster Manager section
of the Server document. You can also set up a separate IP address for the ICM
(see “Setting up a separate IP address for the ICM” on page 98). You can then
start the ICM.

You can configure the ICM settings on one server and have more than one ICM
access these settings. This lets ICMs on different servers share a common
configuration. You should include the ICM configuration information on every
Web server in the cluster, not just the server on which you run the ICM, because
each Web server uses its own Server document to determine how to generate URLs that refer to the ICM. The Web server obtains the host name of the ICM from the Server document. The Web server then uses that host name to generate URLs that reference the ICM.

Use the following steps to configure the ICM:

1. From the Domino Administrator, click the **Configuration** tab.
2. Expand **Server** and click **All Server Documents**.
3. In the **Results** pane, select the Server document for the server on which you want to run the ICM; then click **Edit Server**.
4. Click **Server Tasks - Internet Cluster Manager** tab as shown in Figure 4-1 on page 96.

![Figure 4-1 Internet Cluster Manager tab on Server document](image)

5. Complete the fields identified in Table 4-7.
<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster name</td>
<td>The name of the cluster the ICM will service. If this field is blank, Domino uses the name of the cluster that contains this server.</td>
</tr>
<tr>
<td>ICM Notes port</td>
<td>The name of the Notes port the ICM will use to communicate with HTTP clients. If you leave this field blank, which is the default, the ICM can use any Notes port to communicate with HTTP clients. Enter a port name only if you want to restrict ICM communication to one specific port.</td>
</tr>
<tr>
<td>ICM SSL keyfile</td>
<td>The name of the SSL key file that contains certificates to identify the ICM when communicating with HTTP clients.</td>
</tr>
<tr>
<td>Allow users to browse databases in the cluster over HTTP</td>
<td>Lets HTTP clients view a list of the databases in a cluster. When you enable this field, users can enter \texttt{<a href="http://icmhostname/?OpenServer%7D">http://icmhostname/?OpenServer}</a> as the URL to access. Entering this URL displays a list of databases on the servers in the cluster associated with the ICM named in icmhostname.</td>
</tr>
<tr>
<td>Get configuration from</td>
<td>Lets you specify a different Server document to get configuration information from. This field lets multiple ICMs share the same configuration.</td>
</tr>
<tr>
<td>Obtain ICM configuration from</td>
<td>This field appears when you select “another server document” in the field “Get configuration from.” Enter the name of the server whose Server document contains the configuration you want to use.</td>
</tr>
<tr>
<td>ICM hostname</td>
<td>The fully qualified name of the host that clients should use to communicate with the ICM. This can be the registered DNS name or the IP address. The Domino Web server uses this field to create URLs that reference the ICM. If this field is blank, the Web server will not be able to generate URLs that refer to the ICM.</td>
</tr>
<tr>
<td>TCP/IP port number</td>
<td>Enter the port number for the ICM to use. If you are running the ICM on the same server as the Web server, you must avoid address and port conflicts. If you do not give the ICM its own IP address, be sure the port number the ICM is using is different from any of the other port numbers you use on the server.</td>
</tr>
<tr>
<td>TCP/IP port status</td>
<td>To enable HTTP communication with the ICM, choose Enabled. To disable HTTP communication with the ICM, choose Disabled.</td>
</tr>
</tbody>
</table>
When the ICM starts, it looks at the Server document on the server on which it is running to find the ICM cluster name and its network address. It then obtains the host name and port settings from the same Server document or from the Server document specified in the field “Obtain ICM configuration from”.

If you run the ICM on the same system as a Domino Web server, you must avoid IP address or port number conflicts. The best approach is to assign the ICM its own IP address. You can also have the ICM share an IP address with the Web server if you specify different port numbers for the ICM and the other protocols on the Web server.

### Setting up a separate IP address for the ICM

When you run the ICM on a Web server, you can give the ICM its own IP address to avoid conflicts.

1. Use your operating system to make the IP address available.
2. From the Domino Administrator on the server that contains the ICM, set up a port by doing the following:
   a. Choose Files -> Preferences -> User Preferences.
   b. Click the Ports icon, as shown in Figure 4-2.
c. Click New.

d. Specify a name for the new port, such as ICMPORT (see Figure 4-3 on page 99).

e. Choose TCP as the driver.

f. Click OK twice.

If you are not running the Domino Administrator on the server that contains the ICM, do the following to set up the port:

- Add the following line to the NOTES.INI file:

  Portname=TCP,adapter number or network number,number of sessions,data
  buffer size

  For example: ICMPORT=TCP,0,15,0
3. Add the following to the NOTES.INI file:

```ini
Portname_TcpipAddress=0,IPAddress
```

Where portname is the name of the port you configured from the Domino Administrator, such as ICMPORT, and IPAddress is the IP address you are using for the ICM. For example:

```
ICMPORT_TcpIpAddress=0,192.94.222.169
```

4. In the field “ICM Notes port” on the Server Tasks -> Internet Cluster Manager tab in the Server document, enter the name of the port you configured, such as ICMPORT.

5. If you want to use port 80 for both the ICM and the Web server, you must do the following:
   a. In the Server document, click Internet Protocols -> HTTP tab.
   b. In the “Host name(s)” field, enter the IP address or host name of the Web server.
   c. In the “Bind to host name” field, select Enabled.

### 4.6 Hardware configurations

This section will give you some ideas about how to configure your hardware to achieve better performance on your Domino server.

#### 4.6.1 Hard disk configurations

The following configurations are recommended for iNotes Web Access servers running on NT, Windows 2000, and UNIX platforms:

- Employ just a bunch of disks (JBOD) for the operating system. For production servers, we recommend RAID 0 disk for the operating system.
- Employ just a bunch of disks (JBOD) for the View Rebuild directory. For production servers, we recommend RAID 0 disk for the View Rebuild directory.
- Employ RAID 0 for Domino Data during pre-release testing because of limited in-house availability of disk drives. However, we recommend using RAID 1 or RAID 0+1 for Domino Data. It is best to use smaller disks in a RAID array, and we recommend using disks with capacity under 18 GB each because at this time they generally have faster access times than larger disks.
- Recommended disk speed is at least 10,000 RPM.
It is recommended that the Swap file be located on a separate disk drive. With some operating systems, the default location of the Swap file is the same disk as the operating system itself. If you encounter disk contention, we recommend that you move the Swap file to a different hard drive.

**Note:** Be careful to assign the Swap file to a physically separate disk and not simply to a different partition on the same disk drive. For S/390 and zSeries, configure your page packs as you would normally. As usual, don’t let your Domino server page to disk. If this starts to happen, increase the amount of central/expanded storage available.

To optimize performance for iNotes Web Access, use a hardware RAID controller. The hardware RAID controller does not tax the server CPU to the degree that the software RAID does. For S/390 and zSeries, make sure your DASD control units are caching properly, and watch that channel bandwidth is sufficient.

Lotus has tested on the S/390 and zSeries platforms with different types of disks (DASDs). We recommend the highest-performance disk available, such as an Enterprise Storage Server, but iNotes Web Access will work with older technology disks as well. Performance will be affected accordingly.

### 4.6.2 Memory

Refer to 3.1, “Server and client requirements” on page 40 for more details regarding minimum and recommended configurations for each platform.

### 4.6.3 Other configurations

Refer to 4.3.1, “Configuration and tuning” on page 86 for more suggestions about how to optimize your iNotes Web Access Server for each platform.

### 4.7 Comparing iNotes Web Access performance to Domino WebMail

Although the basic concept of iNotes Web Access and Domino WebMail is the same—allowing users to access Domino services with a Web browser—iNotes Web Access provides a lot of more functionality than Domino WebMail does. In addition, the performance advantage of iNotes Web Access is remarkable. Internal tests showed that iNotes Web Access outperformed Domino WebMail in all tested areas, which were:

- Average CPU utilization
- Average transaction response time
- Number of transactions by CPU utilization

These tests were performed with Domino Release 5.0.8. With Domino Release 5.0.9 there should be an additional increase in server-side scalability, in addition to other performance improvements.

**Performance comparison tests**

The Lotus Enterprise Center of Competence performed a test on two platforms, Windows NT and AIX, to compare the performance of iNotes Web Access and Domino WebMail. The test was not a platform comparison test or a scalability test; the goal for the test was to generate equivalent workload on both servers, one running iNotes Web Access (Domino R5.0.8) and the other one Domino WebMail (Domino R5.0.5).

*Table 4-8  Configuration for the tests*

<table>
<thead>
<tr>
<th>Windows NT</th>
<th>AIX</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 IBM Netfinity 7000 4 x 550 MHz Pentium III</td>
<td>2 RS/6000 4 x 332 MHz</td>
</tr>
<tr>
<td>2 Gb RAM each</td>
<td>3 Gb RAM each</td>
</tr>
<tr>
<td>150 Gb RAID5 EIDE Disk Array each</td>
<td>150 Gb SSA RAID5 Array with</td>
</tr>
<tr>
<td>Windows NT Server 4.0 Service Pack 6a</td>
<td>Fast Write Cache on each server</td>
</tr>
<tr>
<td></td>
<td>AIX 4.3.3</td>
</tr>
</tbody>
</table>

Both Domino WebMail and iNotes Web Access were set up with 1,500 users and mailboxes on Windows NT and AIX servers.

The mailboxes were populated to three sizes as noted in Table 4-9.

*Table 4-9  Mailboxes used in testing*

<table>
<thead>
<tr>
<th>Mailbox size</th>
<th>% used in testing</th>
</tr>
</thead>
<tbody>
<tr>
<td>35 Mb</td>
<td>60%</td>
</tr>
<tr>
<td>60 Mb</td>
<td>30%</td>
</tr>
<tr>
<td>90 Mb</td>
<td>10%</td>
</tr>
</tbody>
</table>

These sizes were selected to represent small, medium and large mailboxes. These sizes do not relate to any production environment. They are just variable sizes that were convenient for the number of users and available disk space.
The functions tested were basic mail functions, available both in iNotes Web Access and Domino WebMail. Advanced mail functions, only available in iNotes Web Access, were not used. The workload was modeled after NotesBench WebMail workload, but it was not an exact match because of different test tools used.

The tests showed that iNotes Web Access performs better on both platforms and on all metrics. The following improvements were shown:

- Average CPU utilization, 35% better
- Average transaction response time, 70% better
- Number of transactions by CPU utilization, 300% better

Another test, made by the IBM zSeries performance team, showed similar results. This test also compared iNotes Web Access performance to Domino WebMail, but this time on IBM zSeries. The results of this test showed average CPU utilization to be 14% better with iNotes Web Access, and the average response time was 63% better. Also, the I/O rate to disk was down by 45%, which had a lot to do with the good response time.

4.8 Caching

Using a Web application can be slow if you need to download a lot of data over the network. In order to minimize the amount of data to be downloaded, as many elements as possible are cached. This can be done on the server or on the client.

4.8.1 Server caching

Traditional Domino Web applications have forms and subforms in each and every end user database that are not cachable across multiple users. With the “outsourcing” of forms and subforms of the iNotes Web Access design into a file called Forms5.nsf (in the iNotes directory on the Domino server), a server-side caching of those elements for all users on the same server has been achieved.

4.8.2 Browser caching

iNotes Web Access makes a distinction between iNotes Web Access design elements and personal data, with respect to the browser’s cache. In general, the HTML in which personal data is generated is set, using the Cache-Control HTTP response header, to a value of “no-cache,” which advises the browser that it should not store the page in the browser’s file-system cache. Design elements such as the JavaScript, .gifs, and blank forms of iNotes Web Access are marked
with a one-year expiration. This facilitates better performance for iNotes Web Access when used over a dial-up connection or in a network environment, since the browser will not attempt to download these design elements if they are already resident in the browser’s cache (assuming the browser’s setting for “Empty temporary Internet files when browser is closed” option is not set.)

For additional information about client-side caching, see 2.9.2, “Private data and browser cache” on page 36.

4.9 Network bandwidth utilization

Network bandwidth utilization by the iNotes Web Access client can vary considerably, depending on many factors. The IBM Westford Lab performance team made tests to determine the bandwidth usage of iNotes Web Access. The observed bandwidth utilization was between 2.7 and 3.2 Kbps/user with short mail messages on a small private 100 Mbit network. In diverse, enterprise networks, however, bandwidth utilization may be as high as 6 to 8 Kbps per user. Estimating the proportion of active users to registered users is a very important step in calculating requirements for network bandwidth. Once your server is configured and running, it will be possible to monitor actual utilization and make adjustments accordingly.
Integration

Lotus Sametime is a real-time collaboration tool that allows you to communicate with others instantly. Sametime provides features like online meetings, awareness, chat, and object sharing.

In this chapter we describe how you can integrate Lotus Sametime into your iNotes Web Access installation. We also show you how iNotes Web Access can be integrated into other Web applications.
5.1 Sametime integration

iNotes Web Access users can communicate with one another via Lotus Sametime, which lets users send and receive instant messages and engage in chat sessions. Users can launch the Sametime user interface by clicking on a link called “Chat” on the iNotes Web Access Welcome page, as shown in Figure 5-1. After the Sametime user interface is launched, users can create their own buddy lists, bringing user names to the list either through Name Picker or simply by typing the name of the user. The steps to create and use buddy lists is described in 5.1.4, “Create a buddy list” on page 108.

Sametime applets exist on each Sametime server in the following directory:

\data\domino\html\SametimeApplet

These applets are the APIs between iNotes Web Access and Sametime. Using forms in Domino, iNotes Web Access links the Sametime applets and brings the instant message to iNotes Web Access users. A user's buddy lists, from the Sametime chat user interface, are kept in the user's mail database; they are brought up whenever the user logs on to Chat again.

![Figure 5-1 Chat button on iNotes Web Access page](image)

**Note:** Users will see the “Chat” button only if Sametime is installed properly.

5.1.1 Installation and configuration of Sametime

**Note:** Running iNotes Web Access server on the same machine or the same Domino server as the Sametime server is not supported. Sametime must be on a dedicated machine.

This section describes the procedure to set up and configure Sametime to run within iNotes Web Access. For more information on configuring the Domino server for iNotes Web Access, see Chapter 3, “Deployment” on page 39 or refer to the Domino 5 Administration Help (help5_admin.nsf). For more information on configuring the Sametime server, refer to the Sametime 2.x Installation Guide.

Following are the high-level steps to set up Sametime.
1. Install the Domino domain server first.

2. Install the Sametime server, Version 2.x on a dedicated server.

3. Configure the Sametime and Domino domain servers to be able to communicate with each other and run unrestricted LotusScript/Java agents (see details in the Sametime 2.x Installation Guide).

4. The required Sametime applets are in the domino\html\SametimeApplet folder under your Domino server's data folder. Copy the Sametime applets folder from the iNotes Web Access server to the domino\html\ folder of your Sametime server. After you copy the applet folder you should have following folders:
   - iNotes Web Access server: c:\Lotus\Domino\Data\domino\html\SametimeApplet
   - Sametime server: c:\Sametime\Data\domino\html\SametimeApplet

   **Note:** On the Sametime server, you will have both a SametimeApplet and sametimeapplets folder after this step. The folder names are case sensitive.

5. Replicate stauths.nsf from a Sametime server to the iNotes Web Access server under the \domino\data directory.

   **Note:** When setting up AIX and Solaris servers to work with dedicated Sametime servers, the setup should be the same as a Windows setup. The only extra step is changing the database name from stauths.nsf to STAuthS.nsf after replicating the database from a dedicate Sametime server (Windows system) to a Domino (iNotes Web Access) server (UNIX system).

### 5.1.2 Configure Domino domain servers for Sametime

The following steps show you how to enable and configure Sametime on your Domino server. There are a couple of values in the server document of your Domino server that you must check and change if necessary.

1. Check the server document of your Sametime server in the Domino domain for the following entries within the Basic tab:
   - Is this a Sametime server?: The value should be Yes.
   - Fully qualified Internet host name: The value should be your Sametime host name, for example: sametime01.acme.com

2. Assign a Sametime server name to the field “Sametime Server” within the Administration tab on each user's person document in the Domino Directory.
To make sure you enter the hierarchical name of the Sametime server, enter it with the canonical format: CN=Domino server name/OU=OrgUnit/O=Org

For example: CN=Sametime01/OU=SRV/O=iNotes

5.1.3 Verify the setup

You can verify that you have performed all the steps correctly and that your installation is working properly by the following:

1. Make sure that replication has completed and the Person documents exist on the Directory of your Sametime server with the Sametime server field populated.

2. (Optional) Test using the Sametime Connect client. Have the user log into the Sametime server using the Connect client or launch Sametime Connect directly from the Sametime server home page.

3. Test that Sametime is working within iNotes Web Access by opening iNotes Web Access in your browser and clicking the Chat button. You should see a Sametime chat window like the one in Figure 5-2.

5.1.4 Create a buddy list

A buddy list is a list of people the user usually chats with. Before users can start chatting with other users, they have to set up their own buddy lists. Use the following steps to set up your buddy lists.
1. From the Sametime awareness window, click **New Group**. Enter an appropriate name and click **Add**. You can add as many groups as you wish. Once a group is created, people can be added to it.

![Add new group dialog](image1)

*Figure 5-3  Add new group dialog*

2. To add a user to the buddy list, select the group first.

3. Enter your colleague’s first name, last name, or both in the blank field and click **Add**. If the entered name is not unique, all matching names will be added. To search for and select the user from a directory, click the **Browse** button, after entering the name, and the address dialog is opened.

*Figure 5-4 shows an example of a buddy list with several groups set up.*

![Sametime awareness window after adding groups and people](image2)

*Figure 5-4  Sametime awareness window after adding groups and people*

In the lower left corner of the Sametime Chat window you can see **your** Sametime status. When the chat window opens it automatically sets you to “I Am Active.” But sometimes you might want to show other users that you are actually online but don’t want to chat for some reason. Therefore, the status can be changed manually by clicking the Sametime status. The following choices are available:
If you choose “Log Off from Sametime” you will get disconnected from the Sametime server. No status will be shown but the Sametime window will remain open, unless you specifically close it. To reconnect to Sametime, just click the Sametime status again and select the only choice available: “Reconnect to Sametime.”

On the Sametime awareness window, icons show the status of each Sametime user you have identified in your buddy lists. We have added text to the screen shown in Figure 5-5 to explain the meanings of the icons.

![Sametime status icons](image)

**Figure 5-5  Sametime status icons**

### 5.1.5 Start chatting

If you want to start chatting with an online user, just double click on the user’s name on the Sametime window and start writing text. Figure 5-6 on page 111 shows an ongoing Sametime Chat waiting for a response.
You have the capability to invite other users to participate in an ongoing chat by clicking *Invite Others*. To leave a chat, just click the *Close* button and the conversation will be terminated.

![Started Sametime Chat dialog](image)

**Figure 5-6  Started Sametime Chat dialog**

### 5.2 Using parts of iNotes Web Access in Web applications

It is possible to use parts of the iNotes Web Access mail file in other Web applications. For example, you could have your own portal application, where you would like to see the mail part of the iNotes Web Access, or there could be an application where you need to refer to the calendar part only to check for availability.

The URLs identified in Table 5-1 can be used to access specific parts of iNotes Web Access.

<table>
<thead>
<tr>
<th>Table 5-1</th>
<th>Available parts of iNotes Web Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td>URL (only the end of the URL is shown here)</td>
</tr>
<tr>
<td>Mail</td>
<td>....nsf/iNotes/Mail/?OpenDocument&amp;ui=portal</td>
</tr>
<tr>
<td>Calendar</td>
<td>....nsf/iNotes/Calendar/?OpenDocument&amp;ui=portal</td>
</tr>
<tr>
<td>ToDo</td>
<td>....nsf/iNotes/ToDo/?OpenDocument&amp;ui=portal</td>
</tr>
<tr>
<td>Contacts</td>
<td>....nsf/iNotes/Contacts/?OpenDocument&amp;ui=portal</td>
</tr>
<tr>
<td>Notebook</td>
<td>....nsf/iNotes/Notebook/?OpenDocument&amp;ui=portal</td>
</tr>
</tbody>
</table>

An example of the selective use of iNotes Web Access follows.
Figure 5-7  A portal that incorporates the mail part of iNotes Web Access

Figure 5-7 shows a personal portal that incorporates a portion of iNotes Web Access. The bottom frame is the mail part of iNotes Web Access.

In this example portal we also have links to other individual parts of iNotes Web Access. They are found in the top frame, where you can click Calendar, ToDo, Contacts and Notebook to access those parts of the program. The format of the links was identified in the preceding table. Clicking one of the links will change the content of the bottom frame.

It is also possible to extend the URL with some arguments to explicitly call a specific view or folder. The name of the variable is PresetFields, and the arguments are shown in Table 5-2 on page 113.
Table 5-2 Arguments for the variable PresetFields

<table>
<thead>
<tr>
<th>Portal</th>
<th>View/Folder</th>
<th>Argument (</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail</td>
<td>Inbox</td>
<td>s_ViewLabel --&gt; Title of view/folder</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Drafts</td>
<td>s_ViewName --&gt; Programmatic name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sent</td>
<td>s_ViewLabel;Inbox,s_ViewName;($Inbox)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>All Documents</td>
<td>s_ViewLabel;Drafts,s_ViewName;($Drafts)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Trash</td>
<td>s_ViewLabel;Sent,s_ViewName;($Sent)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>s_ViewLabel;All Documents,s_ViewName;($All)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>s_ViewLabel;Trash,s_ViewName;($Trash)</td>
<td></td>
</tr>
<tr>
<td>Calendar</td>
<td>One Day</td>
<td>s_CalView;D</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Two Day</td>
<td>s_CalView;T</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Five Day</td>
<td>s_CalView;F</td>
<td></td>
</tr>
<tr>
<td></td>
<td>One Week</td>
<td>s_CalView;W</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Two Week</td>
<td>s_CalView;2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Month</td>
<td>s_CalView;M</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Year</td>
<td>s_CalView;Y</td>
<td></td>
</tr>
<tr>
<td>ToDo</td>
<td>List</td>
<td>s_ToDoView;L</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Chart</td>
<td>s_ToDoView;G</td>
<td></td>
</tr>
</tbody>
</table>

For example, the following URL brings up the Sent view (only the ending part of the URL is shown here):

```
.....&ui=portal&PresetFields=s_ViewLabel;Sent,s_ViewName;($Sent)
```

As another example, the following URL example brings up the One Week calendar view (again, only the ending part of the URL is shown here):

```
.....&ui=portal&PresetFields=s_CalView;W
```
Customization of the iNotes Web Access design

In this chapter we discuss the iNotes Web Access template architecture (from an abstract point of view) and why it is difficult to customize the design. Yet, there are some things that can be customized, with a reasonable amount of work. A couple of examples are covered in this chapter.

This chapter covers the following topics:

- Customization considerations
- Template architecture
- Inheriting from an alternate template
- Customization samples
- Mail view customization
- Customizing existing views or folders
6.1 Customization considerations

Customizing Domino database templates, including the Standard R5 Mail templates, is common among many customers and business partners. This has led to numerous questions regarding what type of customization can be done to the iNotes Web Access 1.0 mail template.

Some areas of iNotes Web Access were not designed in the Domino Designer. For this reason, the design resists the customization techniques familiar to developers who work with other Lotus products.

There is a lot of JavaScript code used in iNotes Web Access. Comments and meaningful text strings are stripped away from the code to optimize performance by minimizing the amount of code that needs to be passed to the client side. Thus it's not necessarily clear what the design elements are, and you're more likely to break something than to safely add your functionality, and changing things in Designer may produce unforeseen results. We recommend that you do not attempt to customize the iNotes Web Access template until the proper guidelines are made available by Lotus or through Lotus' professional services organization.

The iNotes Web Access development team educated personnel from Lotus Professional Services in the process of making design modifications to the iNotes Web Access template. Customers can employ Lotus Professional Services for any design changes that need to be made to the iNotes Web Access design.

6.1.1 Support policy for customization

The following customization disclaimer is an excerpt from the Lotus Knowledge Base, Document #186361 - What is the Support Policy for Customization of the iNotes Web Access Mail template?

The Lotus Knowledge Base is on the Lotus Support Web site at:
http://www.lotus.com/home.nsf/welcome/support

“Customization Disclaimer:
The ability to customize iNotes Web Access 1.0 was not one of the design goals for this release. As such, customized templates are neither certified nor supported. Standard practice for Lotus Notes Support for customers who open incidents resulting from a customized template will be to instruct the customer to revert back to the stock template and see if the problem still occurs. If it does, Lotus Notes Support will troubleshoot the problem as it exists in the stock
template (in other words we will not troubleshoot the customized template). If the problem does not exist in the stock template, Lotus Notes Support shall recommend the customer remove the modifications and submit an enhancement request of the desired functionality for the next release.”

Note: The disclaimer includes Forms5.nsf as well, which is the storage for most of the design of iNotes Web Access.

6.2 Template architecture

The iNotes Web Access template is located in the data directory on your Domino server. The filename is iNotes5.ntf, the database title is iNotes Mail and C&S, and the template name is iNotes5. The iNotes Web Access template inherits fully from the Extended Mail template (Mail50ex.ntf). The Extended Mail template was designed to allow offline usage of Domino mail with the Web browser.

6.2.1 Additional design elements within iNotes5.ntf

The following is a list of additional elements in the iNotes5.ntf template database.

- 2 Agents to support bidirectional synchronization from the Notes client for the Personal Address Book and Journal to the iNotes Web Access Contacts and Notebook areas.
- New views explicitly for iNotes Web Access:
  - New Tasks view
  - View to support Gantt view
  - New Contacts view
  - New Notebook view
  - View to support the iNotes Web Access TOC (Table of Contents)
- Proxy documents, all having titles (field $TITLE) that begin with “iwa”. These are new design element types added for iNotes Web Access. This evolved from QuickPlace’s use of “documents” within their templates. Proxy documents allow accessing design elements via a ?OpenDocument URL.

6.2.2 The Forms5.nsf database

All the forms, subforms, and graphics used by iNotes Web Access (except for certain images in mail views which are either in the Domino icons directory or within the mail template) reside in a separate database located within the <domino data>\iNotes\ subdirectory on the server and named Forms5.nsf.
The reason for keeping design elements in a different single database, instead of in individual mail databases, is that they can be cached on the server. All the Web browsers accessing mail files on a server will use the same design elements, which can be loaded from the server cache. Caching the elements on the server allows better performance on the server.

Figure 6-1 illustrates the relationships between the databases that form the iNotes Web Access mail file and the user interface. The data itself is kept on the mail file, User1.nsf in this case.

6.3 Inheriting from an alternate template

If a company has customized the mail template, the best approach might be to make this customized template be derived from Mail50ex.ntf. The iNotes5.ntf template can then be modified to inherit fully from this customized template. This would allow the company to continue to experience the customization which had been done to the Notes client or WebMail experience. However, most of the customization will not be viewable or usable with the iNotes Web Access client.
6.4 Customization examples

Despite the previous warnings, there are some modifications possible which should not harm the functionality of iNotes Web Access. In this section we describe a couple of customizations you can do yourself.

6.4.1 Change the iNotes Web Access logo to a custom logo

As installed, iNotes Web Access displays its logo in the upper left of the user's screen (see Figure 6-3 on page 120). You can replace the iNotes Web Access logo with a custom logo using the following steps. An example of a custom logo is shown in Figure 6-4 on page 121.

1. Open the \iNotes\Forms5.nsf database (below you Domino Data directory) in Domino Designer.
2. Click the Forms view.
3. Create a new form and give it the following title: Image
4. Create a Rich Text field in this new form and call it anything you want; it's not important what you name the field.
5. Save the form.

![Image form](image.png)

Figure 6-2 Image form

6. Open the \iNotes\Forms5.nsf database in a Notes client.
7. Click the **hResourcesByName** view.
8. Search for the entry iwa.gif on this view.
9. Open the document.
10. Double-click to edit the iwa.gif document.
11. Click the iwa.gif attachment and press the Delete key to delete the attachment.
12. Attach the new logo gif, which must also be named as **iwa.gif**, into the rich text field.
13. Save the document.

**Important:** If you upgrade or reinstall the server code, the Forms5.nsf will be replaced and your changes will be lost. Make a copy of your customized Forms5.nsf before upgrading the server and copy your customized elements back after the update has taken place.

Make sure you've cleared your browser's cache before you open iNotes Web Access. The new logo should now appear in place of the iNotes Web Access logo.

If you don't see the new logo, click the **Refresh** button on your browser, while holding the Ctrl key down. This will cause the browser to retrieve all the elements of the Web page from the server.

Figure 6-3 shows you an iNotes Web Access interface with a standard logo.

![Figure 6-3 iNotes Web Access with default logo](image)

After performing the customization steps, you should see results similar to those shown in Figure 6-4 on page 121.
Chapter 6. Customization of the iNotes Web Access design

6.4.2 Reordering items within the iNotes Web Access TOC

It is possible to change the order in which the top level items of the Table of Contents (TOC) are displayed.

**Note:** The size of the logo should not exceed 185x42 pixels. If you use a bigger logo than this, the layout of the window could be affected.

With this experience you are now able to change other graphics to change the look and feel of the user interface.
You can reorder the TOC by changing the value of the h_Position field within the appropriate proxy document. Proxy documents are new design elements (see 6.2.1, “Additional design elements within iNotes5.ntf” on page 117). Even if they are visible within views, the values of these documents cannot be changed by using an appropriate form, nor can the documents be deleted using the delete key. You can manipulate the values or delete documents by using agents.

Let's assume you want to have your To Do List in the third and your Contacts in the fourth position.

To change the TOC order as described, use the following steps (with a very simple agent).

1. Open the \iNotes5.ntf template in Domino Designer.
2. Click the Agents view.
3. Create a new agent and give it a title, like Change TOC Position. (You can call it anything you want; it's not important what you name the agent).
4. Leave the default for “When should this agent run?” set to “Manually from Actions Menu.”
5. Leave the default for “Which document(s) should it act on?” set to “Selected Documents.”
6. Because the field h_Position is a number field, select “Formula” as the choice for the Run option, rather than “Simple Action(s).”
7. As a simple formula, enter:

   ```plaintext
   newValue := @Prompt( [OkCancelEdit]; "New Position"; "Enter new value for " + h_Name; @Text( h_Position ) );
   FIELD h_Position := @TextToNumber( newValue )
   ```
8. Save the agent.
9. Open the \iNotes5.ntf template in a Notes client as follows: Go to the icon of the template (either in a Bookmark or on the Workspace) and, while pressing the Ctrl+Shift keys on the keyboard, right-click the icon with the mouse. Select Open. The template opens and additionally you can see the hidden views.

10. Click the (HaikuTOC) view.

Figure 6-6  Change TOC Position agent

Figure 6-7  View (HaikuTOC) with default order
11. Select the document(s) you want to change. For our example, select To Do List and Contacts.

12. Select Actions -> Change TOC Position (or the name of the agent you just created in step 3) and you will be asked to enter new values for each selected document. Enter 200000 for To Do List and 300000 for Contacts. The documents will then appear in the new order.

13. Refresh or replace the design of a specific mail file manually, or do it for all mail files with a server task. You can use the convert server task to do this. For instructions, see 3.4.3, “Converting mail files to iNotes Web Access” on page 58, or the section “Upgrading users’s mail files” in the Domino 5 Administration Help database (help5_admin.nsf).

Figure 6-8   View (HaikuTOC) after reordering

Figure 6-9   iNotes Web Access TOC after reordering
6.4.3 Disabling the Welcome page from the iNotes Web Access TOC

If a company doesn’t want their users to access the Welcome page, there is a simple way to remove this entry from the iNotes Web Access TOC.

Use the following steps to disable the Welcome page.
1. Open the \iNotes5.ntf template in Domino Designer.
2. Click the Agents view.
3. Create a new agent and give it a title, like Delete Document (You can call it anything you want; it’s not important what you name the agent).
4. Leave the default for “When should this agent run?” set to “Manually from Actions Menu.”
5. Leave the default for “Which document(s) should it act on?” set to “Selected Documents.”
6. Leave “Simple action(s)” as the choice for the Run option.
7. Click Add Action and select “Delete from Database” as the Action. Click OK.
8. Save the agent.

9. Open the \iNotes5.ntf template in a Notes client as follows: Go to the icon of the template (either in a Bookmark or on the Workspace) and, while pressing the Ctrl+Shift keys on the keyboard, right-click the icon with the mouse. Select
Open. Now you can release the Ctrl+Shift keys. The template opens and additionally you will see the hidden views.

10. Click on the (HaikuTOC) view.

See Figure 6-7 on page 123 for the default view order containing the Welcome Page document.

**Note:** Make sure you make a backup copy of the inotes5.ntf database before proceeding further. After you have deleted the documents, as instructed by the following steps, you cannot undo that. If you need to get the documents back, you can use your backup copy.

11. Select the document with the title **Welcome**.

12. Select **Actions -> Delete Document** (or the name of the agent you just created in step 3) and the document disappears from the view.

![View (HaikuTOC) after deleting the 'Welcome Page' document](image)

**Figure 6-11** View (HaikuTOC) after deleting the 'Welcome Page' document

13. Refresh or replace the design of a specific mail file manually, or do it for all mail files with a server task. You can use the `convert` server task to do this.

For instructions, see 3.4.3, “Converting mail files to iNotes Web Access” on page 58, or the section “Upgrading users’s mail files” in the *Domino 5 Administration Help* database (help5_admin.nsf).
When the user accesses the mail file with a URL like:

http://hostname/mail/filename.nsf?OpenDatabase

iNotes Web Access redirects the user to a URL like:

http://hostname/mail/filename.nsf/iNotes/Mail/?OpenDocument&ui=inotes

Notice the Mail part of the URL instead of Welcome. iNotes Web Access uses the first document in the (HaikuTOC) view to redirect the user. Furthermore, if you also delete the Mail document from that view, you are redirected to the To Do List when accessing the mail file.

6.5 Mail view customization

You can add new views or modify existing ones. Refer to 6.3, “Inheriting from an alternate template” on page 118 for considerations about where to do these customizations. We don’t recommend customizing iNotes5.ntf for the following modifications.

iNotes Web Access gets its mail views from the outline called WebMailOutline. Apart from the Address Book, Discussion and Rules entries, which are for WebMail only, all views are displayed within the mail view navigator.

6.5.1 Addition of new views

If a view is added and enabled for the Web, it should be displayed just below the default views and any folders that have been added within the iNotes Web Access’ mail view navigator as well.
Note: iNotes Web Access' virtual list component does not support hierarchical views, but supports views with categorized columns, which have the Categorized is flat version 5 or greater sort column property set.

To add a new view, use the following steps.

1. Open the appropriate template in Domino Designer.
2. Click the Outlines view.
3. Open the WebMailOutline.
4. Create a new entry at the desired position.
5. For the content, select a named element and the new view.
6. Save the outline.
7. Refresh the design.

iNotes Web Access should display the mail views in the new order.
6.5.2 Customization of existing views or folders

For mail views, iNotes Web Access’ virtual list component should be able to handle adding new columns, or changes to formulas used for the various columns, as well as changes to selection formulas for any of the views. iNotes Web Access calendar views only look within specific programmatic named columns and will not do anything with any additional columns which may be added.

The following figure shows a changed Sent view with reordered columns, and a new column, Size added.

![Figure 6-16 Modified Sent view](image)
Troubleshooting

In this chapter we identify some sources you can turn to for help when installing and running iNotes Web Access. We also discuss some basic troubleshooting techniques which might be helpful if you encounter problems.

This chapter contains the following:

- Places to look for information
- Troubleshooting information
- DOLS troubleshooting
7.1 Sources of helpful information

There are several sources of helpful information available, depending on your needs. This section identifies some of them.

7.1.1 Release notes: Domino/Notes 5.x.x

The Notes database is located in `\help\readme.nsf` for both Domino server and Notes client. Among other useful information, like What’s new or SPR tracking, there is a document called Troubleshooting the Domino server for iNotes Web Access.

After opening the Database, select Troubleshooting on the left navigator.

Within the Server category, expand the iNotes Web Access sub-category. Here you’ll find the document.
7.1.2 Lotus Knowledge Base

To get the latest information on bugs/problems with iNotes Web Access, visit the Lotus Knowledge Base at:
http://support.lotus.com

The easiest way to get all documents related to iNotes Web Access is to *Search by keyword*.

- Just enter "iNotes Web Access" as the search string (including the double quotes)
- Make sure *Lotus Knowledge Base* is selected.
- Click *Go* and check out the search results.

![Lotus Support Home page](image)

7.1.3 Fix List

There is a Fix List Database on Notes.net where you can look for implemented, planned, or coming fixes for all Notes/Domino 5 releases. The URL is:
http://www.notes.net/r5fixlist.nsf
Enter the database and select the view by Prod. area. Expand the **iNotes Web Access** category to see all related fixes. Another interesting view to check out is by Release. There you see the list of fixes categorized by release, in descending order.

![Figure 7-3   Fix List database on Notes.net](image)

### 7.2 Troubleshooting issues

This section contains information on how to solve some of the common problems with iNotes Web Access.

#### 7.2.1 Damaged Welcome page

As described in 3.8, “Welcome page” on page 75, you can define a URL as a default Welcome page for iNotes Web Access.
As with Domino 5.0.9, you have to be careful which characters you're using for the title. For example, the use of an apostrophe or single quotation mark causes the browser to show almost an empty page. With an IE browser version below 5.5 you'll have to confirm lots of JavaScript errors.

The following figure shows how the Welcome page looks with IE 5.5 if you use an apostrophe or single quotation marks within a title, for example *That's the hottest Web site*.

![Figure 7-4  iNotes Web Access with a damaged Welcome page](image)

**Resetting Welcome page settings**

A URL of the following format may be used to reset your Welcome page settings to use the default settings:

http://hostname/mail/filename.nsf/iNotes/Welcome/?OpenDocument&default

### 7.2.2 iNotes Web Access user interface not shown

On some occasions, users keep on seeing the user interface of WebMail although they are already iNotes Web Access users.
The selected user interface, WebMail or iNotes Web Access, is shown until the user specifically calls the other user interface by the URL for the first time. After this, the specified user interface will be used.

Opening the mail file without the &ui= parameter will result in the user interface being iNotes Web Access.

In case you see the wrong user interface, use the following URLs to change the user interface to the desired one.

- iNotes Web Access user interface
  
  http://www.acme.com/mail/jsmith.nsf?OpenDatabase&ui=inotes

- Domino WebMail user interface
  
  http://www.acme.com/mail/jsmith.nsf?OpenDatabase&ui=webmail

### 7.2.3 iNotes Sync Manager incorrectly prompts for master password

Upon launching, the iNotes Sync Manager prompts for the Master Password even though the Master Password has not been set (Figure 7-5).

This behavior occurs if DOLConfig.NSF is missing or damaged. A missing DOLConfig.NSF could be the result of an incomplete install. The solution is to uninstall and reinstall iNotes Sync Manager. Please refer to chapter 3 section 4., “Uninstall Domino Offline Services (DOLS) client software, also known as “Lotus iNotes.”” on page 73.

If the uninstall utility does not function properly due to the incomplete install, follow the instructions in Lotus Knowledge Base technical note #186370 - “How to Manually Uninstall iNotes Sync Manager”.

![Lotus iNotes Sync Manager Password](image)

**Figure 7-5  Lotus iNotes Sync Manager Password**

### 7.2.4 Lotus iNotes installer error

When you attempt to download a subscription of your mail using Internet Explorer, the following error message on Figure 7-6 occurs:
Perform DOLS Checklist in the server. See chapter 3 Section 3.6, “Checklist - DOLS installation” on page 64.

7.2.5 Warning message in log.nsf database

The warning message below appears every time a user attempts to download a subscription from the server and a Security Policy is not found for the user/domain. The system uses the default behavior, prompting end-users to provide ID files when going off-line.

Example 7-1   DOLS Warning message on log.nsf


To avoid this message appearing on your server console, you need to create an Offline Security document in the Offline Services database (dolsadmin.nsf). See detailed instructions in 3.5.2, “Deploying iNotes Web Access for offline users using DOLS” on page 60.

7.2.6 Unable to synchronize the mail file

In some cases, you may encounter problems synchronizing your mail file with DOLS. You might see this happen when you are trying to accomplish synchronization from outside the firewall.

As part of the initial setup of the Lotus iNotes Sync Manager, an offline database called dolnames.nsf is created on the user’s workstation. By default, it is created on the C:\Program Files\Lotus iNotes\DATA directory. This database contains a connection document for the server and this document contains an “Optional Network Address” field. This field should contain a host name. You can see this in Figure 7-7 on page 138.
However, if the notes.ini file of the Domino server contains a "TCPIP_TCPIPAddress=" parameter (one of the options when using Domino partitioned servers to assign a separate IP address for each partitioned server), Lotus iNotes Sync Manager installation puts the IP address specified in that parameter (instead of the hostname) in that field of the Connection document in dolnames.nsf database.

If the clients are outside the firewall, that IP address cannot be resolved, and DOLS synchronization fails.

To work around the issue, use one of the following options:

1. In the notes.ini file of the Domino server, change the value of the line "TCPIP_TCPIPAddress" from an IP Address to a host name, so that the offline Server Connection document is populated with the host name.

   **Restriction:** For this to work, you cannot use the name TCPIP as a port name on your server. Use other port names for your actual functioning TCP/IP ports.

2. Manually open the Offline Address book (dolnames.nsf) with a Notes client. Change the Optional Network Address field contents from the IP address to the hostname. Using the hostname is recommended, as this will not have to be changed in the server's IP address changes.
iNotes Web Access feature comparison

The tables on this appendix compare major features of Domino WebMail, Lotus Notes and iNotes Web Access in several areas. Tables are up-to-date to Domino Release 5.0.9. If you are using a newer release of Domino, see the following URL for an updated version of the table:

http://www.notes.net/inoteswebaccesswelcome.nsf/9ef083dbcc1d1c5c8525695b0050c564/c90f95eaeae7d5738525697e00605a76?OpenDocument

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Views and Folders</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>In-box view</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Drafts View</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>All Documents View</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Discussion Thread View</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Folders</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Feature</td>
<td>Webmail</td>
<td>iNotes Web Access</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------</td>
<td>-------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Nested Folders</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create and delete folders</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Drag &amp; drop messages into folders</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Copy &amp; Move to folder</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>From the action bar, open mail into specific view (i.e. inbox, sent, drafts, etc.)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

**Message Creation and Addressing**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create New Memo</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Type-ahead addressing</td>
<td>No</td>
<td>No, similar results achieved by automatic name resolution</td>
<td>Yes</td>
</tr>
<tr>
<td>Support File Attachments</td>
<td>Yes (limit of 2)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>View file attachments form within message</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Spell checking</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Alternate Name Support</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Sametime Integration</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Perform Name &amp; Address Book lookup</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Display contacts sorted by organizational unit</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Perform Integrated Address book lookup when sending a message</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Personal Contacts Address book</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Delivery Options (Importance, Delivery priority, delivery report)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Forward message</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Save Message Draft</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create a Serial Route Memo</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Feature</td>
<td>Webmail</td>
<td>iNotes Web Access</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>---------</td>
<td>------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Forward web pages and documents from any Notes application</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Forward document as bookmark link message</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>&quot;Copy Into&quot; - convert item to Task, Calendar Entry or New Memo</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Return Receipt</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Prevent Copying</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Apply Mood Stamps to messages</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Create/use stationary</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Choose a Letterhead</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Create a message containing a signature file</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Type-ahead within “Move to Folder” dialog</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Specify outbound message with a “reply by” date</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Specify message expiration date</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Internet Message format</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Viewing and Responding to Message items</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Support for Read/Unread marks</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Navigate to next document without returning to view</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Perform mail file delegation</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Reply w/ history</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Reply to memo</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Reply to All</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Detach Attachments</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>View Rich text within a message</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Feature</td>
<td>Webmail</td>
<td>iNotes Web Access</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>---------------</td>
<td>-------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Support for Doc Links, View Links, and Database Links</td>
<td>Yes, on the same server only</td>
<td>Yes, on the same server only</td>
<td>Yes</td>
</tr>
<tr>
<td>View tables within messages</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create tables within messages</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Resend documents from</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>View sections</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Action Bar</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add Sender of message to Personal Contacts List</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Modify/View the file’s ACL from client</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Display of Importance/Type icons in Views</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Read encrypted mail and verify signature of signed mail</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Preference setting for new mail on top/bottom</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Automatically checking for new messages</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Advanced Editing features in Rich Text field</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Left, Right &amp; Center, indent, outdent text justification</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Tables</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Sections</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for embedded OLE objects</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Java applet support</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Page break</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Horizontal line</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Hotspots</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Insert image resources</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create Sections</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Feature</td>
<td>Webmail</td>
<td>iNotes Web Access</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------</td>
<td>-------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Ability to switch language dictionaries for spell checking</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Support for both Bullets and number lists</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Undo</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>User Preferences</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New mail notification</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Default Mail Send/Save setting</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to archive mail and C&amp;S documents</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Lookup across multiple Address Books</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Automatically create a reply message by clicking on the Form field</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send signed and/or encrypted mail</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Field, form, view, document, section level security</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>User roles</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Local Encryption of Mail database</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Other Features</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control of Database properties/design (refresh, replace, etc.)</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for alternate editors for mail messages</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Built-in news reader, POP mail, IMAP mail</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for Notes/Domino database subscriptions</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Extended Search (w/in databases, attachments, messages, etc.)</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>control of search - refinement of search with form, etc.</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Drag and drop documents between frames</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Feature</td>
<td>Webmail</td>
<td>iNotes Web Access</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>-------------------</td>
<td>-------</td>
</tr>
<tr>
<td>User can change their own password from client</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Table A-2  To Do's

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option to have To Do's follow day-to-day in calendar view</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Display To Do in Calendar view</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Delegate a To Do to another person</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Create To Do's (With Start and End Dates)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Categorize new To Do entries</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Alarm notification on To Do's</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Mark To Do's complete or uncompleted</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create Group To Do'</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to set time on To Do's</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Display To Do's in Gantt chart form</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Priorities for To Do's (High, Medium, and Low)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create personal To Do's</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Owner and Participant actions</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table A-3  Calendaring and Scheduling

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Views</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>From the Action bar, open Calendar into specific view (i.e., 1 day, 1 week, 1 month, etc.)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Calendar Views</td>
<td>1 day</td>
<td>1 day</td>
<td>1 day</td>
</tr>
<tr>
<td></td>
<td>2 day</td>
<td>2 day</td>
<td>2 day</td>
</tr>
<tr>
<td></td>
<td>1 week</td>
<td>5 day</td>
<td>5 day</td>
</tr>
<tr>
<td></td>
<td>2 week</td>
<td>1 week</td>
<td>1 week</td>
</tr>
<tr>
<td></td>
<td>1 month</td>
<td>2 week</td>
<td>2 week</td>
</tr>
<tr>
<td></td>
<td>1 year</td>
<td>1 month</td>
<td>1 month</td>
</tr>
<tr>
<td>Meeting view</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Calendar Print Preview</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Work/non-work hour differentiation</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ability for Chairperson to see status of invitees from the view level</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Calendar Entries and Group Scheduling</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Double-click within the calendar view to create an entry</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create Appointment</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create All Day Event</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create Reminder</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create Anniversary</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create Meeting Invitation</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create rich text in detailed description field</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Automatic date (calendar picture) and time selector controls</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Centrally managed rooms and resources</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create repeating entries</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add alarms to entries</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Feature</td>
<td>Webmail</td>
<td>iNotes Web Access</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------</td>
<td>-------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Attach a file to invitation forms</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Pencil in a meeting / tentatively schedule</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Mark an entry private / “not for public viewing”</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Delivery options on calendar entries</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Address lookup for inviting people</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Check free time availability for invitees</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Free time search within a counter-proposal</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Respond with comments within a counter-proposal</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Edit calendar entries</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Send a reschedule notice</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add additional invitees after invitation is sent</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Send “broadcast” invitation (no RSVPs/responses)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Send meeting confirmation</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Display invitee responses in invitation</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Accept invitation</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Decline invitation</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Counter propose an alternative time</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Accept/decline with comments</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Delegate an invitation</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Check calendar from invitation page</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create and maintain group calendar</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create meeting invitation from group calendar view populating group members in invitation</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Accept counter proposal</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Users in different time zones can share the same server and still see meeting times with respect to their own zone

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### User Preferences

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set global default appointment duration</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Set global default calendar entry type</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Option to make free time available to only certain users</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Options to set allowable free time</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Enable conflict checking for calendar entries</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Allow another user to manage Calendar without allowing access to e-mail</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Mark default calendar entry as “not for public viewing”</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Autoprocessing of Calendar information

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option to remove invitations from Inbox after processing</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to autoprocess invitations</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table A-4  Personal Contacts

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort contacts by Last Name, Company, e-mail, Address, etc.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add users in Domino Directory to Personal contact list</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Select multiple contacts and send message</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Select multiple contacts and schedule a meeting</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Business Card Summary view</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Categorization of contacts</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Automatically add e-mail sender to Personal contact list</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Table A-5  Attachments

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlimited Attachments</td>
<td>No</td>
<td>Yes (Maximum 2)</td>
<td>Yes</td>
</tr>
<tr>
<td>Drag and drop attachments from desktop/file system</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table A-6  Miscellaneous

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browser Support</td>
<td>Internet Explorer 4.x</td>
<td>Internet Explorer 5.x</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Internet Explorer 5.x</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Netscape Navigator 4.x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Search (contextual by text, author, or date)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Journal integrated in mail file</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Contacts integrated in mail file</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ability to snooze alarms across multiple sessions/logins</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Context sensitive help</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Offline support for Messaging, PIM and Collaborative Applications</td>
<td>Mail only</td>
<td>Messaging PIM</td>
<td>Yes</td>
</tr>
<tr>
<td>Welcome Page Support</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Mail view filter for unread messages</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Mail view filter for high priority messages</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Mail view filter for last 10 messages</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>
Appendix B. Additional material

This redbook refers to additional material that can be downloaded from the Internet as described in the following sections.

Locating the Web material

The Web material associated with this redbook is available in softcopy on the Internet from the IBM Redbooks Web server. Point your Web browser to:

ftp://www.redbooks.ibm.com/redbooks/SG246518.zip

Alternatively, you can go to the IBM Redbooks Web site at:

ibm.com/redbooks

Select the Additional materials and open the directory that corresponds with the redbook form number.
Using the Web material

The additional Web material that accompanies this redbook includes the following files:

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SG246518.zip</td>
<td>Zipped sample database containing design elements used in the user migration example.</td>
</tr>
</tbody>
</table>

System requirements for downloading the Web material

The following system configuration is recommended:

- **Operating System:** Windows/32
- **Processor:** Any
- **Memory:** Any

How to use the Web material

Create a subdirectory (folder) on your workstation, and unzip the contents of the Web material zip file into this folder.
Related publications

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this redbook.

IBM Redbooks

For information on ordering these publications, see “How to get IBM Redbooks” on page 154.

- *Lotus Notes and Domino Take Center Stage: Upgrading from R4 to R5*, SG24-5630
- *Lotus Notes and Domino R5.0 Security Infrastructure Revealed*, SG24-5341
- *Lotus Sametime 2.0 Deployment Guide*, SG24-6206
- *Lotus Domino R5 for Sun Solaris*, SG24-5969
- *Lotus Mobile and Wireless Solutions*, SG24-6525

Other resources

Lotus Domino R5 Administration Help, help5_admin.nsf

These Lotus Whitepaper publications, available from the Lotus Web site, are also relevant as further information sources:

- *iNotes Web Access Deployment Guide*
- *Best Practices Guide Maximum Performance at Minimum Expense: Optimizing Your Current Domino Applications and Server Platforms*
- *Domino R5 Performance and Scalability*

Referenced Web sites

These Web sites are also relevant as further information sources:

- Lotus iNotes product page
  http://www.lotus.com/home.nsf/welcome/inotes
How to get IBM Redbooks

Search for additional Redbooks or Redpieces, view, download, or order hardcopy from the Redbooks Web site:

ibm.com/redbooks

Also download additional materials (code samples or diskette/CD-ROM images) from this Redbooks site.

Redpieces are Redbooks in progress; not all Redbooks become Redpieces and sometimes just a few chapters will be published this way. The intent is to get the information out much quicker than the formal publishing process allows.

IBM Redbooks collections

Redbooks are also available on CD-ROMs. Click the CD-ROMs button on the Redbooks Web site for information about all the CD-ROMs offered, as well as updates and formats.
Special notices

This publication is intended to help server administrators deploying iNotes Web Access to understand how to best install, deploy and configure iNotes Web Access for their own environment. The information in this publication is not intended as the specification of any programming interfaces that are provided by the iNotes Web Access product.

References in this publication to IBM products, programs or services do not imply that IBM intends to make these available in all countries in which IBM operates. Any reference to an IBM product, program, or service is not intended to state or imply that only IBM’s product, program, or service may be used. Any functionally equivalent program that does not infringe any of IBM’s intellectual property rights may be used instead of the IBM product, program or service.

Information in this book was developed in conjunction with use of the equipment specified, and is limited in application to those specific hardware and software products and levels.

IBM may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, North Castle Drive, Armonk, NY 10504-1785.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact IBM Corporation, Dept. 600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The information contained in this document has not been submitted to any formal IBM test and is distributed AS IS. The use of this information or the implementation of any of these techniques is a customer responsibility and depends on the customer's ability to evaluate and integrate them into the customer's operational environment. While each item may have been reviewed by IBM for accuracy in a specific situation, there is no guarantee that the same or similar results will be obtained elsewhere. Customers attempting to adapt these techniques to their own environments do so at their own risk.
Any pointers in this publication to external Web sites are provided for convenience only and do not in any manner serve as an endorsement of these Web sites.

The following terms are trademarks of other companies:

Tivoli, Manage. Anything. Anywhere., The Power To Manage., Anything. Anywhere., TME, NetView, Cross-Site, Tivoli Ready, Tivoli Certified, Planet Tivoli, and Tivoli Enterprise are trademarks or registered trademarks of Tivoli Systems Inc., an IBM company, in the United States, other countries, or both. In Denmark, Tivoli is a trademark licensed from Kjøbenhavns Sommer - Tivoli A/S.

C-bus is a trademark of Corollary, Inc. in the United States and/or other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and/or other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States and/or other countries.

PC Direct is a trademark of Ziff Communications Company in the United States and/or other countries and is used by IBM Corporation under license.

ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel Corporation in the United States and/or other countries.

UNIX is a registered trademark in the United States and other countries licensed exclusively through The Open Group.

SET, SET Secure Electronic Transaction, and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC.

Other company, product, and service names may be trademarks or service marks of others.
Symbols
&ui= 43, 111, 136

A
Access levels 22
Accessing from different places 42
ActiveX 65, 85
Adobe Acrobat Reader 36, 40
Alarms 45
Alternate name 45
Anonymous access 20, 67
Archiving 45
Authentication 10

B
Bandwidth 43, 104
Browser cache 30, 36

C
Capacity planning 80
Changing the Internet password 23, 25
Client performance 84
Client requirements 40
Clustering 94
Co-existence of clients 41
Converting users 49
Cookies 36
Customization 115
  architecture 117
  considerations 116
  examples 119
  logo 119
  views 127
  welcome page 125

D
Delegation privileges 26
Deploying clients 59
Design replication 41
Directory assistance 74
Directory catalog 74
DOLS 8, 48, 60, 85, 94, 137
  admin database 63
  DSAPI filter names 62
  installation 60, 64, 137
  installation CD 67
  offline use 70
  performance 94
  security policy document 63
  synchronizing 70
  troubleshooting 136
  uninstalling 72
  Domino cluster 94
  Domino Everyplace 8
  Domino Off-Line Services 8
  See DOLS
  Domino server 41, 42, 60
  Domino Web server 47
  Domino WebMail 7, 42, 101, 139
    comparing performance to iNotes Web Access 101
  Dropping the Notes client 49

E
Encryption 27, 29, 46
Execution Control List 32

F
Feature comparison 139
Firewall 34, 35
Forms5.nsf 3, 27, 85, 103, 117, 120
Full-text indexing 45

G
General guidelines for customizing 116

H
Hardware configurations 100
Hardware sizing tools 80
HTTP commands 48
HTTP settings 46
HTTP task 47

I
ICM
  configuring 95
  IP addresses 98
iNotes 2
iNotes Access for Microsoft Outlook 2, 6
iNotes Web Access 2, 5
  architecture 117
  archiving 45
  comparing features 139
  comparing performance to Domino WebMail 101
controlling access 20
deployment 39, 60, 77
features 139
integrating to Web applications 111
integration 105
Internet password 25, 45
messaging workload 81
migrating users 48
offline usage 48, 60
performance tests 81
printing 45
server document settings 44
synchronize contacts 49
synchronizing contacts 48
synchronizing journal 48
synchronizing personal groups 48
template 41
uninstalling 72
user interface settings 43
welcome page 75, 125
iNotes5.ntf 3, 59, 60, 117
Installation steps 77
Integration 105
Internet Cluster Manager 94
Internet password 15, 25, 45

J
JavaApplet 85
JavaScript 35, 116
Journal 48

L
Linux 7
Login 11, 22
Logout 12, 16, 30, 36
Lotus iNotes Sync Manager 2, 8, 72, 136
Lotus Notes 4

M
MAIL.BOX files 89
Mail50ex.ntf 118
Migrating users 48
Migration scenarios 48
Mixed environment 41
Mobile Notes 8

N
nconvert command 58
Netscape Navigator 7
NotesBench 81

O
Offline use 8, 48, 70
OS/2 7
Out of Office agent 24

P
Password 25
PDA 8
Performance
caching 85, 92, 103, 118
compared to Domino WebMail 101
DOLS 94
fine tuning 89, 91, 93
Hard disks 100
HTTP thread settings 91
iSeries 87
JavaApplet 84
mixed workload test 83
network bandwidth utilization 43, 104
network timeout values 89
pSeries 87
scalability tests 81
server caching 92
server task priorities 93
Sun Solaris 87
tests 81
view rebuilding 91
Windows 2000 86
zSeries 88
Personal Address Book 48
Ports 35
Preferences 25, 26, 29
Preferred language 45
Proxy documents 117
Proxy server 33

Q
QuickPlace 117

R
Redbooks Web site 154
Contact us x
Reverse proxy 33
Reverse proxy server 34

S
Sametime 106
  buddy list 108
  configuration 106
  installation 106
  integration 105
  JavaApplet 106
Scalability 80
Security 9
  Access Control List 20
  access levels 22
  active content filtering 33
  anonymous access 20, 67
  authentication 10
  authentication over SSL 14
  basic authentication 10
  caching information 16, 30
  changing the Internet password 24
  clearing the browser cache 30
  client certificates 33
  control access 20
  cookie 36
  different access levels 20
  enabling SSL 18
  encrypting databases 27
    locally 29
  encryption 37
  example of an ACL 21
  firewall 35
  login 22
  logout 12, 16, 30
  maximum access
    for Web users 22
  minimum access level 24
  reverse proxy 33
  securing the environment 33
  session authentication 30
  session-based authentication 11
  workstation security 16, 30, 33, 36
Security policy document 63
Server configuration document 44
Server deployment 77
Server performance 85
Server requirements 40

Session authentication 11
SSL
  authenticating over 14
  enabling for connections 18
Synchronizing
  contacts 48
  journal entries 48
  personal groups 48

T
Templates 116
Testing mixed workload 83
Testing peak performance 82
Troubleshooting 131

U
Uninstalling 72
UNIX 7
Upgrading mail files 58
User interface 43
Using a single mail file 42

V
View customization 127

W
WAP 8
Welcome page 45, 75, 125, 135

X
XML 36
Deploy iNotes Web Access in your organization

iNotes Web Access is a next-generation Web client that allows you to utilize the most popular Domino functionality with a Web browser. You can work on your mail, use your calendar for personal and group scheduling, and do some advanced task management. In addition, you have access to your contact information and a journal-like notebook. iNotes Web Access also has a customizable Welcome page. This IBM Redbook offers you information on how to best install, deploy, and configure iNotes Web Access for your environment. It describes how to make your installation secure, keeping unwanted visitors outside of your iNotes Web Access installation yet allowing your users to access their mail files from outside the corporate firewall.

If your organization uses Notes clients to access mail and other services of Domino, you will still find iNotes Web Access useful. A scenario where these clients coexist is explained, and upgrading to such an environment is described in detail.

All the functionality of iNotes Web Access is available for you online as well as offline. How to enable offline access to iNotes Web Access with Domino Off-Line Services is presented.

This redbook gives you details for capacity planning so you can size your environment correctly and describes how to get the best performance out of your servers. It also gives you information on how to integrate Lotus Sametime into your iNotes Web Access environment.

We describe the architecture of iNotes Web Access and, finally, offer some examples of how to make modifications to iNotes Web Access.

Make an iNotes Web Access environment secure

Plan for capacity

SG24-6518-00

ISBN 0738424137